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新規機能と拡張機能

この本では、本ソフトウェア製品の本リリースでのワークフローの新機能、拡張機能、

および変更についての概要を説明します。

Character Controls の拡張機能
Character Controls ウィンドウの統合により複数のキャラクタのセットアップ
タスクが容易になります。次の図は、既定モードの Character Controlsウィ
ンドウを示したものです。

A. Character Controlsメニューボタン、B.スタートペイン、C. Characterメニュー、D.
Sourceメニュー

Character メニュー

シーン内のキャラクタのリストからユーザが選択できるようにし、アクティブな

キャラクタの名前を表示します。

このメニューのオプションは次のとおりです。

■ --- None --- - シーンに HumanIK キャラクタが存在しないときに表示されま
す。

1
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注: このオプションを選択すると、スタートペインに戻ります。

■ Character — 現在のキャラクタを選択した HumanIK キャラクタに設定し
ます。キャラクタは名前順に一覧表示されます。

Source メニュー

Sourceメニューでは、
■ キャラクタに動きを与えるソースタイプについてのフィードバックが提供さ

れます。このメニューは、アクティブの HumanIK ツールとは無関係に
Character Controlsでウィンドウで使用できます。

■ さまざまな操作の後にキャラクタの状態への変更を反映するため更新します。

ドロップダウンリストからオプションを手動で選択することによって、キャ

ラクタのソースタイプを設定できます。

Start ペイン

Character Controlsウィンドウの Startペインを使用すると、キャラクタ設
定プロセスを素早く開始することができます。このペインは、スケルトンの定義

中、HumanIK スケルトンの作成中、またはシーンへのモーションキャプチャ
例の読み込み中であっても、設定プロセスをガイドするように設計されていま

す。

キャラクタをMotionBuilderにロードすると、 Character Controlsウィン
ドウが以下のように表示されます。
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A.現在のキャラクタの名前、B. Character Controlsツールバー、C. Definitionタブおよ
び Controlsタブ、D.スケルトンの表示、E.右手のビューに進む、F.左手のビューに進
む、G.右足のビューに進む、H.左足のビューに進む
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キャラクタを設定するときに、以前の独立した HumanIK ツールは統合された
Character Controlsでタブとして表示されるようになり、キャラクタの設定
プロセスが簡略になりました。

各タブには、さまざまな HumanIK ツールが含まれています。Startペイン、
Sourceメニュー、またはCharacter Controlsメニューボタンで特定のオプ
ションを選択すると、 Skeletonタブ、 Definitionタブ、および Controls
タブが表示されます。

Character Controls のメニューボタン

キャラクタコントロールをわかりやすく分類するために、Create、Define、
Edit、および Add to Selectionなどのメニューが追加されています。

Create >

アクターやコントロール リグを作成するオプションを提供します。

Actor定義したキャラクタのソースとして使用する光学式モーションキャプチャ
データをマッピングするアクターを作成できます。

Control Rig定義済みのスケルトン構造に基づいた IK および FK エフェクタを
使用して、現在のキャラクタのコントロールリグを作成します。コントロール

リグを作成する前に、キャラクタには有効なスケルトン定義が必要です。

Define >

Skeletonスケルトンの定義を作成します。これはコントロールリグの作成、
キャラクタのスケルトンに対するアニメーションのリターゲットに必要です。
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Edit >

アクター、スケルトン定義、およびコントロールリグのパラメータを編集しま

す。

Actor >

Lock 選択したアクターおよびそのマーカーセットの現在の位置と回転をロッ
クします。このオプションは、 Resourcesウィンドウ > Properties > Actor
プロパティからオンにすることもできます。

IK Manipインバースキネマティクスを使用してアクターを操作します。既定
では、チェックボックスがオフになりアクターの各ボディセグメントを操作し

ます。

Symmetry Editアクターの手足を同時にスケーリング、および変換します。既
定では、このチェックボックスがオンになっています。このチェックボックスを

オフして、手足のサイズまたは長さを個別に変更します。

Stance Poseアクターを既定のスタンス位置に配置します。このポーズを使用し
て、アクターの位置をリセット、および修正できます。 Stance Poseでリセッ
トされるのは回転オフセットだけです。モデルを移動またはスケールした場合、

これらのオフセットはそのままになります。

Collapseアクターのサイズやスタンスをリセットせずに、アクターのデタッチ
された手足セグメントを再結合します。これは、位置のオフセットをアクターに

追加する場合、またはソースマーカーを初期の定義より遠くに移動する場合に

必要になることがあります。マーカーセットによって定義されたすべてのマー

カーに合わせるためにいくつかの手足がデタッチされる場合があります。

Reset Size選択したアクターのスケールを既定のサイズにリセットします。ス
ケーリングオフセットがセグメントの位置に影響する場合、 Reset Sizeを選
択すると、アクターのスケールはリセットされますが、セグメントの位置はその

ままになります。

Find Size このオプションは、アクターが T スタンスのときに選択したマーカー
セットとソースマーカーに基づいてアクターの各セグメントの計算とサイズ変

更を行います。

Reset Pivot Pointsアクターのすべてのピボットポイントを元の位置に戻しま
す。

Reset All Stance Pose、Collapse、および Reset Sizeの各オプションを同
時にリセットします。このオプションでは、アクターは既定の立脚位置に戻り、
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すべてのデタッチされた手足セグメントは再結合されて、アクターのスケールも

既定のサイズにリセットされます。

Edit Properties  Propertiesウィンドウでは「オブジェクト名.プロパティ名」
と示されます。 Propertiesウィンドウに表示されるプロパティは、Character
Settingsのオプションで表示されるものと同じです。

Switch to Actor現在のキャラクタとアクターが切り替わります。Switch To
Actorを選択すると、 Character Controlsウィンドウが Actorタブに変わ
ります。 Characterメニューで Switch to Actorオプションを有効にする
と、現在のキャラクタのソースがアクターになります。

Definition >

Lock Definitionスケルトンが Definitionタブにマップされたら、スケルト
ンの現在の設定をロックします。スケルトン定義は、ロックする前に、有効に

なっていなければなりません。

Rename HIK キャラクタの名前を変更できます。

Delete現在の HIK キャラクタを削除します。

Skeleton Lock Selスケルトンの選択をロックまたはロック解除します。このオ
プションがアクティブな場合、スケルトンを選択できません。

Skeleton Lock Trsスケルトンを選択できても、位置と回転がロックされている
のでスケルトンを座標変換できなくなります。

Edit Properties  Propertiesウィンドウでは「オブジェクト名.プロパティ名」
と示されます。 Propertiesウィンドウに表示されるプロパティは、Character
Settings のオプションで表示されるものと同じです。

Reset Properties現在のキャラクタの定義および/またはソルビングプロパティ
を既定の値にリセットします。 Reset Propertiesを選択することは、
Navigatorウィンドウ> Character Settingsペインで Reset All Properties
ボタンをクリックするのと同じことです。

Mirror Matchingミラー一致モードを有効にします。このオプションをオンに
すると、 Definitionタブはマップするすべてのボーンについてボディの反対
側でミラー一致を検査します。たとえば、L_upperLeg という名前のボーンを
マップした場合、ツールはスケルトンで R_upperLeg ボーンを自動的に検査し、
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そのボーンが存在する場合は自動的にマップします。既定値では、ミラー一致

モードは次の部分文字列のペアをサポートします。

右側左側

RightLeft

R (後にスペースが 1個)L (後にスペースが 1個)

R_L_

_R_L

ボーン命名規則でこれら以外の部分文字列を使用してボディの左側と右側を示す

場合は、  > Edit > Definition > Configure Mirror Matching を
選択して独自の文字列を追加できます。

Configure Mirror Matching  Mirror Configurationウィンドウを開きま
す。このウィンドウでは、 Definitionタブがミラー一致するボーン名を検索
するリストに文字列のペアを追加できます。ボーン命名規則でこれら以外の部分

文字列を使用してボディの左側と右側を示す場合は、このオプションを選択して

部分文字列を追加します。

Load Skeleton Definition  Load Skeleton Definitionウィンドウを表示し
ます。ここでは自身の命名テンプレートを適用して、ボーンをマッピングできま

す。現在のキャラクタがロックされている場合、このオプションをクリックする

と、キャラクタのロックを解除するメッセージが表示されます。

Save Skeleton Definition  Save Skeleton Definitionウィンドウを開いて、
スケルトン詳細を保存します。

Switch to Actor現在のキャラクタとアクターが切り替わります。 Character
メニューでこのオプションを有効にすると、現在のキャラクタのソースがアク

ターになります。このオプションを選択すると、 Character Controlsウィン
ドウが Actor Controlsウィンドウに切り替わります。

Controls >

Rig Look使用するコントロールリグエフェクタのスタイルを選択できます。
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Rig Look A.ボックス B.棒 C.ワイヤ

Stance Poseコントロールリグを既定の T-スタンスポーズにリセットします。

注: 二足歩行キャラクタと四足歩行キャラクタのスタンスポーズは異なります。

Retarget Rig  Source として選択されているキャラクタのコントロールリグか
ら現在のキャラクタのコントロールリグにキーフレームアニメーションがコピー

されます。このオプションを選択すると、 Retargeting Optionsダイアログ
ボックスが表示されます。このダイアログボックス内のオプションでは、リター

ゲット中にキーフレームの追加を許可するかと Character Extension アニメー
ションをコピーするかを決定できます。オリジナルのアニメーションをできる

だけ正確にリターゲットすることを心掛ける場合は、Add Keyframesオプショ
ンを有効化することをお勧めします。リターゲットプロセスではアニメーショ

ンはほぼ正確にコピーされますが、ソースキャラクタとターゲットキャラクタ

の違いを補正するために微妙な調整が必要です。このような微妙な変化を大目に

見てキーフレームをまったく追加しない場合は、Add Keyframesオプション
を非アクティブにしてください。

Rename現在のキャラクタのコントロールリグの名前を変更します。

Delete現在のキャラクタのコントロールリグを削除します。

FK Lock Sel FK マーカーの選択をロックまたはロック解除します。このオプショ
ンをアクティブにすると、FK マーカーを選択できなくなります。FK マーカーを
非表示にするには、このオプションを無効にします。

FK Lock Trs FK マーカーの座標変換をロックまたはロック解除します。このオ
プションをオンにすると、FK マーカーを選択できても座標変換することはでき
ません。
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Reach Override操作時に Pull の値と連動して、エフェクタのピン(固定)状態と
キャラクタの動作を決定します。このオプションは既定ではアクティブです。こ

れは各エフェクタの Pull (プル)の値がキャラクタの操作中に無視されることを意
味します。Pull 設定はアニメーションを再生しているときにだけ表示されます。

キャラクタに座標変換を適用しているときに引きの効果を見るには、Reach
Overrideオプションを無効にします。キャラクタの動作は、エフェクタのピン
(固定)状態ではなく、エフェクタの個々の Pull の値に依存するため、エフェクタ
のピンも無効になります。

Reach Overrideオプションは、Full BodyモードまたはBody Partモード
のときにだけアクティブです。

Stiffness Overrideキャラクタの動作を Stiffness の値に応じて操作する場合、
キャラクタをどのように動作させるかを決定します。

Stiffness Overrideオプションは既定ではアクティブです。これはキャラクタ
の操作中にキャラクタは Stiffness 値を使用しないということです。Stiffness 設
定はアニメーションを再生しているときにだけ適用されます。

Stiffness Overrideオプションは、Full Body モードまたはBody Partモー
ドのときにだけアクティブです。

Rig Connect >

Attach Rigシーンでコントロールリグを表示します。コントロールリグを選択
すると、 Attach Control Rigおよび Reset Control Rig Hierarchyダイ
アログボックスが表示されます。

■ コントロールリグ階層を既定構造にリセットする場合は、 Yesを選択しま
す。既定のリグに関する詳細は、ヘルプの「コントロールリグの階層」を参

照してください。

または

■ Noを選択して、以前に作成したペアレント化やカスタマイズをすべて含め、
現在のコントロールリグ構造を保持します。

コントロールリグの構造がキャラクタに一致しない場合、必要に応じてエフェ

クタを作成する、または無効にしてコントロールリグを適合させます。たとえ

ば、適合しない指を含むキャラクタのコントロールリグを結合すると、指のエ

フェクタが無効になります。キャラクタが元のコントロールリグを持っている

場合、そのコントロールリグはデタッチされ、新しいコントロールリグと置き

換えられます。元のコントロールリグは Scene Browser ではまだ使用可能で一
覧表示されますが、キャラクタには既にコネクトされていません。
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Load UI Configuration  Select new configuration fileウィンドウを表示
します。 Controlsタブに対する新規の既定レイアウトとして使用するカスタ
ム設定ファイルを選択できます。

Update UI Configuration  Controlsタブ設定ファイルを再ロードします。
Load UI Configurationコマンドで設定ファイルを読み込んだ後、このオプ
ションを使用して、設定ファイルに加えた変更を表示します。

Add to Selection >

IKすべての IK エフェクタを選択します。

FKすべての FK エフェクタを選択します。

Skeletonすべてのジョイントオブジェクトを選択します。

Show/Hide >

このメニューのオプションを使用すると、選択したキャラクタの各コンポーネン

トの表示を有効または無効にできます。

IK IK リグは、IK エフェクタを使ってキャラクタを座標変換できるインバース
キネマティクスシステムです。このシステムを使ってキャラクタを操作すると、

ボディをその階層と関連付けながら人間の体の動きと同じように動かすことがで

きます。

FK FK リグはコントロールリグ機能の半分です。FK リグはモデルのオリジナル
なスケルトンに基づいて作成されます。

Skeletonスケルトンを使用してキャラクタが使用するノードを定義します。コ
ントロールリグは、モデルのスケルトンに基づいて作成されます。

Floor Contact キャラクタの足、手、指、足指先がシーンのフロアに接触した
ときの反応を定義できます。

Finger Tips キャラクタの指先または足指先に使用されるコンタクト球面の表
示/非表示を切り替えます。

Actor (All)  5 つのオプションを使用し、アクターに関連するインタフェース項
目を非表示または表示状態にすることができます。これらのオプションは、現在

のキャラクタまたはソースがアクターの場合にのみ使用できます。

Actor Bodyアクターのボディの表示(既定)/非表示を切り替えます。アクターの
ボディを非表示にするにはこのオプションを無効にします。
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Actor Skeletonアクターのボーンを表す接続された線の集合を表示します。ボー
ンだけを表示するには、 Actor Skeletonをオンにして Actor Bodyをオフ
にします。

Marker Set 定義されたマーカーセットに属するマーカーの表示/非表示を切り
替えます。このオプションは、アクターのボディの周りに白いマーカーで表示さ

れます。マーカーセットを非表示にするにはこのオプションを無効にします。

Source Markersモーションデータを含むマーカーの表示(既定)/非表示を切り替
えます。ソースマーカーを非表示にするには、このオプションを無効にします。

Marker Set と Source Markers が両方ともアクティブである場合は、既定時、
マーカーセットに属するマーカーがソースマーカー内に表示されます。

Pivot Pointsアクターのピボットポイントの表示/非表示を切り替えます。ピ
ボットポイントマーカーを非表示にするにはこのオプションを無効にします。

既定では、ピボットポイントはオレンジ色の十字で表示されます。ピボットポ

イントの表示方法を変更するには、 Propertiesウィンドウの Actor Settings
を使用します。 Body Part Pivotsプロパティを使用して、ピボットポイント
の位置を調整することもできます。

へルプの「 Character Controlsのメニューボタン」を参照してください。

Definitionタブ

このタブは、スケルトンの構造をマップするためのビジュアルインタフェース

を提供します。このプロセスの結果、コントロールリグの作成や、キャラクタ

のスケルトンに対するアニメーションのリターゲットに必要な HumanIK スケ
ルトンが定義されます。これを、HumanIK 定義キャラクタといいます。

Character Controls の拡張機能 | 11



DefinitionタブA.ツールバーB. CharacterビューおよびName MatchビューC. Skeleton
プロパティ
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スケルトン定義を作成するには、 をクリックします。

ボーンをマップするには、次のようにナビゲートします。

■ Definitionタブからスケルトンへ:  Characterビューのセルをダブルク
リックし(選択時にセルの色が青に変わる)、シーン内の対応するボーンをク

リックします。

または

■ スケルトンから Definitionタブへ: ボーンを選択し、Characterビュー
の対応するセルを右クリックして、Assign Selected Boneを選択します。

マップされたボーンを変更するには

1 セルを右クリックして Change Assigned Boneを選択します。

2 ドロップダウンリストから一覧表示されたボーン名を選択するか、使用す

るボーンの名前を入力します。

3 [Enter]を押すか、OKをクリックします。

マップされたボーンをクリアするには

1 Characterビューのセルを右クリックし、 Clear Assigned Boneを選
択します。

選択されたボーンの名前がドロップダウンリストに表示されます 

2 [Enter]を押すか、OKをクリックします。

現在のビューでマップされたすべてのボーンをクリアする(ボディ全体、手、足、

または脊椎ビュー)には

1 ビューの任意の箇所で右クリックします。

2 Clear All in Viewを選択します。

現在のキャラクタに対してマップされたすべてのボーンをクリアするには

1 ビューの任意の箇所で右クリックします。

2 Clear Allを選択します。

Character Controls の拡張機能 | 13



ボーンのミラーペアをマップするには

1  > Edit > Definition > Mirror Matching を選択します。

ヒント: または、 Definition ツールバーの をクリックします。

2  > Edit > Definition > Configure Mirror Matching を選
択して、 Mirror Configurationウインドウを開きます。

このウィンドウに、ミラー一致モード用に現在設定されているすべてのサ

ブストリングペアのリストが表示されます。

3 サブストリングをそれぞれ追加または削除するには、[+]または[-]ボタンを
クリックします。

ヘルプの「Definitionタブ」を参照してください。

Definition タブツールバー

このツールバーには、スケルトン定義のファイルへの保存およびファイルからの

ロードや、現在のスケルトン定義のロックなど、スケルトン定義の管理に使用で

きる一連のグローバルコントロールが用意されています。また、ミラー一致モー

ドを有効化および設定するためのコントロールや、マッピングテンプレートを

適用および保存するためのコントロールもあります。

空のスケルトン定義を作成します。

現在のスケルトン定義をロックおよびロック解除します。

注: キャラクタ定義をロックすると、Character Definition ペイ

ンでマッピングリストが自動的に更新されます。

ミラー一致モードを切り替えます。
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Load Skeleton Definitionウィンドウを表示します。このウィン
ドウでは、マッピングテンプレートを適用したり、複数のボーン

を名前で自動的にマップします。

Save Skeleton Definitionウィンドウを表示します。このウィン
ドウでは、後日ロードできるマッピングテンプレートを保存しま

す。

現在のスケルトン定義を削除します。

ヘルプの「Definitionタブツールバー」を参照してください。

Character ビューおよび Name Match ビュー

キャラクタ(Character)ビューと名前の一致(Name Match)ビューを使用して、
キャラクタのボーンを対応する HumanIK ノードにマップし、現在のマッピン
グの情報を表示することができます。どちらのビューでもノードのマッピングに

は同じコントロールを使用しますが、ノードの表示レイアウトは異なります。

ビュー内の任意の場所で右クリックし、コンテキストメニューから Character
Viewまたは Name Match Viewオプションを選択してビューを切り換えま
す。

Character ビューメインの Character ビューは、HumanIK ノードを Biped の
各ボーンの配置を示す概略配置にレイアウトします。このビューでは、キャラク

タの構造をマッピングするビジュアルツールが提供され、スケルトン定義のス

テータスについてのフィードバックが提供されます。
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Characterビュー A.検証ステータス B.他のビューへ C.必須ボーン D.ロールボーン E.
リファレンス

手、足、脊椎、肩、および首のビュー手、足、脊椎、肩、および首の詳細な

ビューに切り替えて、これらのボディパーツに追加のボーンをマッピングする

ことができます。ビューを特定のボディパーツに切り替えるには を、

Character ビューに戻るには をクリックします。

キャラクタのさまざまなビュー A.手 B.足 C.手へ D.右肩へ E.首のビューへ F.左肩へ G.
脊椎へ H.足へ I.右肩 J.左肩 K.脊椎

Validation status Character ビューの右上に、検証ステータスインジケータが
表示されます。

スケルトン定義は有効です。有効
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注意が必要なキャラクタの領域に関する情報につい

ては、検証ステータスのエラーメッセージフィー

ルドを参照してください。

黄色の記号は、マップされたボーンの位置が正しく

ないことを示します。たとえば、ロールボーンを回

警告

転させたときに、X軸が下向きにならない場合など
です。Characterビューも更新され、位置が正しく
ないボーンがハイライトされます。

スケルトン定義は無効です。必要なボーンが一部不

足しているか、複数のボーンの位置が正しくない可

能性があります。

無効

Name Matchビュー関連するボディパーツまたは IK エフェクタに従ってグ
ループ化されたリスト内のすべてのボーンが表示されます。このビューを使用す

ることで、スケルトン定義の概要がわかり、複数の異なるノードに割り当てられ

たボーンの名前を表示することができます。Character ビューの場合と同じ方法
を使用して、 Name Matchビューにボーンをマッピングすることができます。
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ヘルプの「CharacterビューおよびName Matchビュー」を参照してください。
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Load Skeleton Definition ウィンドウと Save Skeleton Definition ウィンド
ウ

Load Skeleton Definitionウィンドウ複数のボーンを名前で自動的にマッピン
グするため、命名テンプレートを選択できます。このウィンドウを開くには、

Definitionタブツールバーの をクリックします。

Templateこのドロップダウンリストには、一般的なボーン命名規則がいくつ
か表示されます。適用する命名テンプレートを選択します。

■ HIK - HumanIK 命名規則を使用して作成したスケルトンに使用します。

■ CAT - Character Animation Toolkit (CAT)を使用して作成した Biped スケ
ルトンに使用します。

■ Biped - 3ds Max Biped で作成した Biped スケルトンに使用します。

独自に保存した命名テンプレートを選択するには、 Browseを選択します。

Match scopeプレフィックス規則に基づいてボーンをマッチするか、選択した
ボーンのみをマッチするかを選択します。

Save Skeleton Definitionウィンドウ現在のスケルトン定義内にあるボーンの
名前に基づいて命名テンプレートを抽出できます。このウィンドウを開くには、

Definitionタブツールバーの をクリックします。

Template Nameテンプレートの名前を入力します。この名前が、 Load
Skeleton Definitionウィンドウのテンプレートのリストに追加されます。

Example Bone現在のキャラクタ階層の中で最初の有効なボーンの名前を表示
します。

Prefixテンプレートに追加されたすべてのボーン名の先頭から削除するプレ
フィックス文字列を入力します。現在のキャラクタのボーン名に、その特定キャ

ラクタを表す標準的なプレフィックスが含まれている場合に役立ちます。 これ

はたとえば、各ボーン名の先頭にキャラクタ名を付加した場合などです。プレ

フィックスを入力すると、テンプレートに追加されたすべてのボーン名から、そ

のプレフィックスが自動的に削除されます。

Load Skeleton Definition および Save Skeleton Definition ウィンドウの詳細
は、ヘルプの「Definitionタブツールバー」を参照してください。
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Controls タブ

Controls タブには次のものが含まれています。

■ Controls ツールバー

■ キャラクタ表示

■ HumanIK コントロール
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Controlsタブ A.ツールバー B.キャラクタ表示 C. HumanIKコントロール
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次の表では、 Controlsタブを使用するタスクの概要を説明します。

方法機能

Sourceメニューから Control Rigを選択
します。

コントロールリグを作成する

または

> Create > Control Rigを選択し
ます。

> Edit > Control > Rig Lookを選
択し、エフェクタのスタイルを選択しま

す。

リグエフェクタの外観を変更する

をクリックします。

Full Bodyキーイングおよび操作モードに
変更する

をクリックします。

Body Partキーイングおよび操作モードに
変更する

をクリックします。

キャラクタのスケルトンを表示します。

Sourceメニューから HumanIK定義キャ
ラクタを名前別に選択します。

現在のキャラクタのアニメーションソー

スを設定する

IKエフェクタセルを右クリックし、
Create Aux Effectorまたは Create Aux
Pivotを選択します。

補助エフェクタまたはピボットエフェク

タを作成する

シーンでエフェクタを選択し、[Delete]キー
を押します。

補助エフェクタまたはピボットエフェク

タを削除する
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方法機能

対応する IKエフェクタセルを選択し、

をクリックします。

Translationのエフェクタをピンする

対応する IKエフェクタセルを選択し、

をクリックします。

Rotationのエフェクタをピンする

をクリックします。

すべてのピンを一時的に解放する

> Bake > Bake To Skeletonを選
択します。

アクティブソースを現在のキャラクタに

ベイク処理します。

(または)

> Bake > Bake To Control Rig
を選択します。

> Edit > Definition > Edit
Propertiesを選択します。

Attribute Editorでリターゲットパラメー
タを編集します。

ヘルプの「Controlsタブ」を参照してください。

Controls ツールバー

Controlsタブのツールバーに次のものが含まれています。
■ Show/Hide ボタン

■ Manipulation モードと Keying モード

■ Pinning

■ その他のボタン
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表示/非表示(Show/Hide)

これらのアイコンを使用し、FK エフェクタ、IK エフェクタ、スケルトンの表示
を切り替えることができます。

キャラクタの IKエフェクタを表示または非表示にします。IKの表示/非
表示

(Show/Hide
IK)

キャラクタの FKエフェクタを表示または非表示にします。FKの表示/非
表示

(Show/Hide
FK)

キャラクタのスケルトンを表示または非表示にします。スケルトン

の表示/非表
示

(Show/Hide
Skeleton)

ヘルプの「Controlsタブツールバー」を参照してください。

Manipulation モードと Keying モード

これらのアイコンは、キャラクタのコントロールリグを使用するための操作お

よびキーフレーム操作モードを設定できます。キャラクタのボディ全体(Full
Body)、ボディの一部分(Body Part)、または選択したエフェクタのみに対する
(Selection)キーフレームの操作および設定が可能です。

ツールをFull Bodyのキーイングと操作モードに設
定し、個別のエフェクタを選択してキャラクタ全体

Full Body

を操作できるようにします。たとえば、Full Body
モードでキャラタの手首エフェクタを移動すると、

その影響を受けてボディ全体が手首エフェクタに合

わせて動きます。

このモードで強制的にスタンスポーズに設定する

と、キャラクタ全体が強制的にスタンスポーズに設
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定され、キャラクタはリファレンスノードに対して

オフセットされます。

ツールを Body Partモードに設定し、選択したエ
フェクタに基づいてボディの単一の部分でキーを操

作および設定できるようにします。

このモードで強制的にスタンスポーズを設定する

と、選択されたボディパーツを強制的にスタンス

Body Part

ポーズに設定します。ヒップが選択の一部の場合、

キャラクタはそのリファレンスノードに対してオフ

セットされます。

ツールを Selectionモードに設定し、選択したエ
フェクトだけを操作およびキーイングできるように

します。

このモードでは、キャラクタの残りの部分を解決し

ないで 1つのエフェクトを操作し、HumanIKコン

Selection

トロールを使用してキャラクタの他の部分がそのエ

フェクタに合わせてどのように動くかを調整できま

す。

Character表示では、操作およびキーイングに対してアクティブになっている
キャラクタの部分がわかるように、セルに白いハイライトが表示されます。たと

えば、Body Part操作モードでは、左手首のエフェクタを選択すると、
Character表示で左腕のすべてのセルが白くハイライトされます。

固定

これらのアイコンを使用して、エフェクタへの固定のアクティブ化、無効化、ま

たは一時的なリリースを行うことができます。

固定を行うと、キャラクタのより細かい操作が可能になり、特定のエフェクタの

移動または回転をコンストレイントしつつ、キャラクタ位置の他の部分を調整で

きます。たとえば、手首を回転時には固定し、移動時には動かせるようにするこ

とで、手首や腕の調整を行うときに、手首を動かせるが回転はしないようにでき

ます。

HumanIK コントロールリグを作成する場合、既定ではキャラクタの足の IK エ
フェクタの移動と回転は固定されます。
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固定のフィードバックは、キャラクタ(Character)リプリゼンテーションで、各
セルに表示されます。

選択したエフェクタの移動を固定/固定解除します。移動の固定

(Pin
Translation)

固定すると、選択したエフェクタは移動できなくなり、キャラ

クタ(Character)リプリゼンテーションの対応するセルに「T」
が表示されます。

選択したエフェクタの回転を固定/固定解除します。回転の固定

(Pin
Rotation)

固定すると、選択したエフェクタは回転できなくなり、キャラ

クタ(Character)リプリゼンテーションの対応するセルに「R」
が表示されます。

選択したエフェクタと、そのチェーン下流にあるエフェクタに

ついて、移動時または回転時の固定を一時的にすべて解除しま

す。

全ての固定

を解除

(Release All
Pinning)

ヘルプの「Manipulationモードと Keyingモード」を参照してください。

スタンスポーズ Stance Pose アイコン( )は、コントロールリグを既定の

T-スタンスポーズにリセットします。 Full Bodyモードでこのアイコンを選択
すると、キャラクタ全体にスタンスポーズを強制的に設定し、キャラクタの位

置はリファレンスノードに対してオフセットされます。Body Partモードで
は、選択されたボディパーツは強制的にスタンスポーズに設定されます。ヒッ

プが選択の一部の場合、キャラクタはそのリファレンスノードに対してオフセッ

トされます。なお、この機能は Selectionモードには適用されません。

ヒント:  > Edit > Controls > Stance Pose を選択してスタンスポー
ズを強制的に設定することもできます。

キャラクタ表示をコントロールする

二足歩行のキャラクタのイメージと、HumanIK コントロールリグをアニメー
トするために使用できるすべてのエフェクタを表示します。
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スケルトン定義のコントロールリグを作成すると、キャラクタビューではリグ

の IK と FK エフェクタごとにセルが表示されます。これらのセルは、各エフェ
クタに対して定義されている固定、IK ブレンド、IK 引き寄せの視覚的なフィー
ドバックとなっています。また、補助エフェクタとピボットエフェクタの作成

と選択も可能です。

IK セルのステータス

キャラクタビューの各 IK セルは、対応するエフェクタのステータスを反映する
ために更新されます。以下の表はセルごとのさまざまな状態を示しています。

Selection

エフェクタの状態セル

Selected

非選択

アクティブなキーインググループ(Full Bodyまたは Body Part)
の一部として選択されています。

ピン
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エフェクタの状態セル

移動でピン

回転でピン

移動と回転でピン

IK Blendおよび IK Pull

エフェクタの状態セル

IK Blend Tが 1.00に設定されます。

IK Blend Rが 1.00に設定されます。

IK Blend Tおよび IK Blend Rが 1.00に設定されます。

IK Pullが 1.00(さらに IK Blend Tおよび IK Blend Rが
1.00)に設定されます。

IK Pullが 0.50に設定されます。

補助エフェクタとピボットエフェクタ
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エフェクタの状態セル

メインエフェクタには補助エフェクタがあります。表示

するには[+]アイコンをクリックします。

メインエフェクタにはピボットエフェクタがあります。

表示するには[+]アイコンをクリックします。

補助エフェクタ

ピボットエフェクタ

ボディパーツ(Body Part)ビュー

キャラクタ(Character)ビューの手足の横にある矢印アイコン を使用する

と、拡大ビューに切り替えることができるため、キャラクタの手足の内部で個々

のエフェクタを選択できます。各ビューの右上隅の手または足のアイコンをク

リックすると、左のボディパーツと右のボディパーツが切り替わります。

手
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フィート

ヘルプの「キャラクタ表示」を参照してください。

HumanIK コントロール

HumanIKコントロールの IK Blend Tスライダおよび IK Blend Rスライ
ダ(以前は Reachと呼ばれていた)を使用して、スケルトンがどのソリューショ
ン(IK または FK)に従うかを決定することができます。コントロールリグにキー
フレームを設定すると、IK ソリューションと FK ソリューションの両方がキー設
定されます。

合理化されたウィンドウサイズ

ControlsタブのBiped (二足歩行)キャラクタのイメージには、このタブが
Definitionタブよりも小さくなる、新しいA-frameレイアウトが含まれてい
ます。
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ボディパーツのスタンスポーズ

選択したボディパーツにスタンスポーズを強制的に設定できます。アクティブ

の操作モードまたはキー設定モードによって、クイックアクセスアイコン

または  > Edit > Controls > Stance Pose を選択することによって
スタンスポーズを強制的に設定したときの、コントロールリグの反応が決まり

ます。

これは、キャラクタのポーズを作成するために、特定のボディパーツのみをリ

セットする必要がある場合に、ポーズからポーズへのキャラクタアニメーショ

ンの間に役に立ちます。

ヘルプの「Blendコントロールと Pullコントロール」を参照してください。

ヘッドアップディスプレイ

モーションピクチャには 3D アセットだけでなく、シーンまたはショット内に
含まれるさまざまなアスペクトと通信する追加情報も含まれる必要があります。

ヘッドアップディスプレイ(HUD)は、特定のシーンに関するタイトル、テイク
名、フレームレート、シーン名などをビューアに表示するのに役立ちます。

HUDは、 Asset Browser > Templates > Elementsサブディレクトリ内の
アセットとして使用できます。
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HUD アセットを現在のカメラまたはシーンに
追加する

Asset Browserの HUD アセットをカメラまたはシーンに追加する必要があり
ます。こうするだけで、HUD 要素を HUD アセットに追加し、その要素の情報
を Viewerに表示できるようになります。

HUDアセットをアクティブのカメラまたはシーンに追加するには

1 HUD アセットを Asset Browserから Viewerウィンドウにドラッグし
ます。

2 コンテキストメニューから Add to Current Cameraまたは Add to
sceneを選択します。
■ Add to Current Camera — このオプションを選択すると、1 つの

HUD アセットを現在のカメラに追加し、別の HUD アセットをシーン
に追加します。
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現在のカメラに追加された HUD アセットは、シーンに追加された HUD
アセットのペアレントとして動作します。

■ Add to scene — HUD アセットをシーンにのみ追加します。この
HUD アセットのペアレントは、どのカメラにもありません。

注: 複数の HUD アセットをシーンに追加できますが、カメラに追加でき
る HUD アセットは 1 つだけです。

2 つめの HUD アセットを現在のカメラに追加しようとすると、コンテキ
ストメニューに Replace Current Camera's HUDオプションが表示
されます。

このオプションを選択すると、現在のカメラの HUD アセット置き換えて、
別の HUD をシーンに追加します。この場合、置き換えられて追加された
HUD アセットの名前は HUD 1 となります。

HUDアセットをシーンまたはカメラから別のカメラに追加するには

1 HUD アセットをシーンまたはカメラから目的のカメラにドラッグします。

2 Add to Cameraコンテキストメニューオプションをクリックします。

HUDアセットをシーンまたはカメラから削除するには

1 シーンまたはカメラの HUD アセット上で右クリックします。

2 コンテキストメニューから、 Deleteを選択します。
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カメラの HUD アセットがシーンの別の HUD アセットのペアレントの場
合、またはその逆の場合、両方の HUD アセットが削除されます。

ヒント: シーンまたはカメラの HUD アセットをクリックすると、そのペ
アレントまたは子階層の HUD アセットがハイライトされます。これは、
削除する HUD アセットが独立しているか、別の HUD アセットにアタッ
チされているかどうかを確認するのに役立ちます。

HUDアセットをカメラからデタッチするには

1 カメラの HUD アセット上で右クリックします。

2 コンテキストメニューから、Detach HUD From <カメラ名>を選択し
ます。

<カメラ名>には、HUD アセットが属するカメラの名前が表示されます。
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Detach HUD From <カメラ名>オプションを選択すると、シーンに子
HUD アセットを含んでいても、カメラからだけ HUD アセットがデタッ
チされます。

ヘルプの「HUDアセットを現在のカメラまたはシーンに追加する」のト
ピックを参照してください。

HUD 要素を理解する

HUD 要素は 14 個あり、これらを HUD アセットに追加して、シーンに関する
追加情報(静的および動的)を Viewerに表示することができます。

Contentプロパティテキストボックスに
入力するテキスト「HUD要素のプロパ
ティ」のセクションを参照してください。

Text

イメージ、イメージシーケンス、または

ビデオ

Texture

バックグラウンド、もしくは静的コンテン

ツまたは動的コンテンツのマスクとして使

用可能なベクトルグラフィック

Rectangle

.swfファイル形式で保存されるフラッシュ
アニメーション

Flash

レコードライトRecord Light

Texture HUD 要素イメージ、イメージシーケンス、またはビデオ( File >
Import Video )を読み込むと、 Navigatorウィンドウ > Texturesフォルダ
の下に表示されます。

HUD Texture要素からのテクスチャを Viewerに表示するには

1 Textureプロパティの ボタンをクリックします。

読み込まれたすべてのテクスチャを含む Texturesフォルダが表示されま
す 
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2 テクスチャのチェックボックスをオンにします。

または、 Navigator > Textures フォルダからテクスチャをドラッグして
Viewerにドロップします。

Flash HUD 要素

HUD Flash要素のフラッシュアニメーションを Viewerに表示するには

1 Flash File Pathプロパティの ボタンをクリックします。

Open Directoryウィンドウが表示されます。

2 フラッシュアニメーション(.swf形式)を選択します。

3 Openをクリックします。

Record Light HUD 要素レコードライトを使用すると、ステージオペレータ
はシーンのレコーディング状態を把握することができます。既定では、レコード

ライトの色はグレーです( )。この色が変化してレコーディングの段階

が表示されます。

意味表示させるために
クリックする
Transport
Controlsのボタ
ン

レコードライトの色

レコーディングの準

備完了

Record

緑( )

レコーディングが進

行中

Play

赤( )
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意味表示させるために
クリックする
Transport
Controlsのボタ
ン

レコードライトの色

レコーディングは停

止、MotionBuilder
Stop

白い×印のある赤( )
はレコーディング後

のプロセスでビ

ジー。レコーディン

グ後のプロセスの

後、レコードライ

トはグレーに変わり

ます(既定の状態に

戻ります)。

次の表に、動的 HUD 要素と Viewerに表示される情報を一覧表示します。

フレームまたはTimecodeでの編集タイムラインの現在の
時間

EditTime

既定の、フレームでの編集タイムラインの現在の時間EditFrame

フレームまたは Timecodeでのアクションタイムライン
の現在の時間(最低値は 0で、最大値はシーンの長さ)

ActionTime

選択されている 1秒あたりのフレームレート(fps)。fpsは
重いシーンでは下がり、軽いシーンでは上がります。ス

SceneFrameRate

ムーズな再生ができるように可能な最高のフレームレー

トを最適化します。

現座のテイクの名前です。値は数字または文字列になり

ます。

TakeName

HUDが属するカメラの名前です。CameraName

HUDが属するカメラの焦点距離です。CameraFocalLength
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現在のシーンの名前です。SceneName

システムの空きメモリです。重いシーンをロードできる

かどうかの判断に役立ちます。

FreeMemory

オブジェクトのプロパティ(立方体、キャラクタ、ステレオカメラなど)を HUD
要素に追加し、シーンでプロパティの値を参照することもできます。

ヘルプの「HUD要素を理解する」のトピックを参照してください。

HUD 要素を HUD アセットに追加する

HUD 要素を現在のカメラの HUD アセットに追加し、その要素の情報をViewer
に表示する必要があります。

HUD要素を現在のカメラの HUDアセットに追加するには

1 現在のカメラの HUD アセットを選択します。

2 Navigatorウィンドウの右ペインで、 New...をクリックします。

Heads Up Display Entryダイアログボックスが表示されます。

ドロップダウンリストには選択できる 14 個の HUD 要素が含まれていま
す。既定では、Text要素が選択されています。
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3 (任意)  Enter a field nameテキストボックスで既定の名前 (HUD 要素)
を変更します。

注: 既定の名前を変更せずに 2 つ以上の HUD 要素を追加すると、2 つ目
の要素の名前には HUD Element 1、3 つ目の要素の名前には HUD Element
2 などが割り当てられます。

4 Create をクリックします。

Navigator ウィンドウの現在のカメラの HUD アセットの下に HUD 要素
が表示されます 

現在のカメラの HUD アセットがシーンの HUD アセットのペアレントの
場合、現在のカメラに追加されたすべての HUD 要素がシーンの子階層の
HUD アセットの下にも表示されます。

上記の手順に従って複数の HUD 要素を HUD アセットに追加して、シーンに関
する役立つ詳細を伝えることができます。
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例:

注: また、Python SDK および C++ ORSDK を使用してすべての HUD 要素のタ
イプを追加および編集することができます。『MotionBuilderSDK Help』を参照
してください。

ヘルプの「HUD要素を HUDアセットに追加する」のトピックを参照してくだ
さい。
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HUD 要素のプロパティ

HUD 要素のプロパティは、Viewerに表示するコンテンツの外観、位置、およ
びサイズを変更する際に役立ちます。HUD アセットの下の HUD 要素をクリッ
クすると、要素のプロパティが Navigatorウィンドウの右ペインに表示されま
す 

HUD 要素のプロパティは、4 つのカテゴリにまとめられています。

HUD要素のプロパティ A. Display B. Position C. Scale D. Property References

■ Display — 要素の外観を変更します。

■ Position — シーン内の要素の位置を変更します。

■ Scale — X 軸および Y 軸に沿って要素のサイズを拡大、縮小します。

■ Property References — HUD 要素がプロパティ値を Viewerに表示す
る際に参照するプロパティ名を表示します。たとえば、現在のテイク名を表

示するために、TakeName HUD 要素は HUD.TakeNameプロパティの値
(Take 001)を参照します。

注: Property Referencesカテゴリは、動的 HUD 要素に対してのみ表示
されます。
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次の表では、Display、Position、および Scale カテゴリ内の各プロパティを説
明しています。

説明Displayプロパティ

Viewerでの HUD要素コンテンツの可視性をコントロールし
ます。

既定では、このプロパティはすべての HUD要素に対してオ
ンになっています。

Visibility

Viewerでコンテンツを非表示にするには、チェックボックス
をオフにします。

表示するテキストを入力します。

動的要素では、変数 %sまたは %dの前か後ろにテキストを
入力します。

Content

テキストまたは動的コンテンツが表示されるフォントを選択

します。

既定のフォントは Arialです。

Font

HUD要素コンテンツの可視性を増減し、フォントの色を変更
します。

コンテンツの既定の色は白です。

Color RGB

HUD要素コンテンツのバックグラウンドの可視性を増減し、
バックグラウンドカラーを変更します。

コンテンツのバックグラウンドは、このプロパティのAの値
が 0を超えている場合のみ確認することができます。

Background Color

バックグラウンドの寸法は、コンテンツのスケーリングと直

接比例します。

r, g, b, aサブプロパティは、Color RGBおよび Background
Colorプロパティの R、G、B、および Aカラーボックスと
機能的に似ています。

r, g, b, a
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説明Displayプロパティ

HUD要素コンテンツのフォーマットをFramesからTimecode
に強制的に変更します。

このプロパティは、EditTimeおよび ActionTime HUD要素
に対してのみ有効にできます。

Force Display As
Timecode

Microsoft Windows オペレーティングシステムにインストールされた
MotionBuilderにシーンを作成することを考えてみましょう。シーンには多く
の HUD Text要素が含まれ、各々が異なるフォント(Garamond、Helevtica な
ど)を使用しています。シーンを保存し、UNIX オペレーティングシステムにイ
ンストールされたMotionBuilderを使用してこれをロードします。UNIX オペ
レーティングシステムにシーンファイルで使用されている 1 つまたは複数の
フォントが含まれていない場合、次の Warningダイアログボックスが表示さ
れます 

このダイアログボックスでは使用できないフォントが一覧表示され、代わりに

使用されているフォントが通知されます。最初に、MotionBuilderが(既定の)
Arial フォントを使用できるかチェックします。Arial フォントが使用できない場
合、次のフォントが使用可能であるかどうかを所定の順でチェックし、使用可能

であれば使用します。

1 Helevtica

2 Sans

3 FreeSans

4 つのフォント(Arial、Helevtica、Sans、および FreeSans)のいずれも使用でき
ない場合、HUD Text要素フォントリストの先頭に表示されるフォントが使用
されます。

HUD 要素コンテンツのフォントカラーを変更するには

■ R、G、または B カラーボックスをクリックし、カーソルをドラッグします。

または
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■ R、G、または B ボックスのいずれかをダブルクリックし、0.00～1.00 (既定
値は 1.00)の値を入力します。

または

■ ボタンをクリックして、Colorウィンドウを開き、希望のカラーを選
択します。ヘルプの「Colorウィンドウ」のトピックを参照してください。

注: HUD 要素コンテンツのバックグラウンドカラーも変更するには、上記のア
クションのいずれか 1 つを実行してください。

HUD 要素コンテンツの可視性のレベルを増減するには

■ A (Alpha)ボックスをクリックし、カーソルをドラッグします。

または

■ A ボックスをダブルクリックし、0.00～1.00 (既定値は 1.00)の値を入力しま
す。

説明Positionプロパティ

Viewerでの HUD要素コンテンツの効果的な位置を設定しま
す。たとえば、HUD要素のコンテンツを Viewerの中央に表

Justification

示するには、Justificationドロップダウンリストおよび
Horizontal Dockドロップダウンリストから Centerを選択
する必要があります。

要素コンテンツを Viewerの左、中央、右に水平にドッキン
グします。

ドッキングは、 Justificationプロパティが参照するグローバ
ルな基準点です。

Horizontal Dock

要素コンテンツを Viewerの下部、中央、上部に垂直にドッ
キングします。

Vertical Dock

HUD要素コンテンツの水平位置をドッキングおよび両端揃え
の位置に関して変更します。

プロパティ値をクリックして、X軸に沿ってドラッグして要
素の位置を変更します。ボックスをダブルクリックして、値.
を入力することもできます。

X
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説明Positionプロパティ

HUD要素コンテンツの垂直位置をドッキングおよび両端揃え
の位置に関して変更します。

プロパティ値をクリックして、Y軸に沿ってドラッグして要
素の位置を変更します。ボックスをダブルクリックして、値.
を入力することもできます。

Y

Xおよび Yの値を割合で表示します。Xは、Viewerの幅の
割合としての、HUD要素の水平位置です。
値をピクセルで表示するには、チェックボックスをオフにし

ます。

Position by Percent

説明Scaleプロパティ

HUD要素コンテンツまたはバックグラウンドの幅(水平のス
ケーリング)を増減します。

Width

HUD要素コンテンツまたはバックグラウンドの高さ(垂直の
スケーリング)を増減します。

Height

HUD要素コンテンツの幅および高さを割合でスケーリングし
ます。要素をピクセルでスケーリングするには、このチェッ

クボックスをオフにします。

Scale by Percent

HUD要素コンテンツの幅および高さを均一に増減します。Scale Uniformly

次のことを行います。Adjust Width to Fit Text

■ テキストを追加または削除するときのサイズを維持しま

す。

■ Widthプロパティを無効にします。

■ Scale Uniformlyプロパティをオフにすることを禁止し
ます。

ヘルプの「HUD要素のプロパティ」のトピックを参照してください。
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HUD 要素のプロパティをカスタマイズする

HUD 要素のプロパティは、別のアセットのプロパティまたはカスタムプロパ
ティを追加することによってカスタマイズすることができます。これは、Viewer
にシーンに関する情報をより詳しく表示する際に役立ちます。

オブジェクトプロパティを HUD 要素のプロパティ

に追加する

別のアセットのプロパティを Resources > Asset Browser > Templates ディ
レクトリに追加することによって、HUD 要素のプロパティをカスタマイズする
ことができます。

注: コマンドオブジェクトのプロパティは、 Resources > Properties ディレ
クトリに表示されないため、 Resources > Asset Browser > Templates >
Commands ディレクトリに追加することはできません。

オブジェクトの各プロパティは、 Propertiesウィンドウでは「オブジェクト
名.プロパティ名」と示されます。たとえば、stereoCameraオブジェクトの
Field Of Viewプロパティは、 stereoCamera.Field Of View となります。

HUD要素のプロパティに別のオブジェクトのプロパティを追加するには

1 Resources > Asset Browser > Templates > Elements フォルダか
ら、stereoCameraオブジェクトを Viewerにドラッグアンドドロッ
プします。

ステレオカメラが Viewerに表示されます 

2 Camera FOV という Text HUD 要素を作成します。

3 この Text HUD 要素のプロパティから、Yプロパティの値を、ステレオ
カメラの上部のテキスト(Camera FOV)の位置に変更します。
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4 Navigatorウィンドウで、[Ctrl]キーを押しながら、Camera FOV HUD
要素をクリックします。

Camera FOV HUD 要素のプロパティと stereoCameraアセットのプロ
パティの両方が、 Resources > Properties ウインドウに表示されます 

5 Resources > Properties > stereoCamera プロパティの下の Field Of
Viewプロパティをクリックし、これを Camera FOV HUD 要素プロパ
ティにドラッグアンドドロップします。

Create 1 Reference Propertyコンテキストメニューオプションが表
示されます 
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6 このコンテキストメニューオプションをクリックして、Camera FOV HUD
要素のプロパティに Field Of Viewプロパティを追加します。 Field Of
Viewプロパティの値が Viewerに表示されます 

ViewerウィンドウとResourcesウィンドウA. Field Of ViewプロパティB. Camera
FOV HUD要素のプロパティに追加された Field Of Viewプロパティ C. Field Of
Viewプロパティの値

Field Of Viewプロパティの値を調整すると、値の変化がシーンに動的に表示
されます 

ヒント: または、オブジェクトのプロパティを Resources > Propertiesウィ
ンドウからドラッグして、 Navigatorウィンドウの HUD 要素にドロップする
こともできます。

シーン(.fbx形式)を保存すると、別のシーンで再利用できるように、追加された
すべての HUD 要素およびそのプロパティも保存されます。
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カスタムプロパティを HUD 要素のプロパティに追

加する

Property Editor > Custom Propertiesウィンドウからカスタムプロパティ
を追加することによって、HUD 要素のプロパティをカスタマイズすることがで
きます。これは、Viewerにより詳しい情報を表示する際に役立ちます。

ヘルプの「Custom Propertiesペイン」のトピックを参照してください。

カスタムプロパティを HUD要素のプロパティに追加するには

1 Navigatorウィンドウの右ペインの Editorボタンをクリックします。

Property Editorウィンドウが表示されます。

2 Custom Propertiesタブをクリックします。
■ Add Propertyペインにカスタムプロパティが表示されます 

■ Destinationペインに、追加したすべての HUD 要素が表示されます 

3 Add Propertyペインで、カスタムプロパティを選択します。

4 Destinationペインで、カスタムプロパティを追加する HUD 要素を選
択します。

5 Create Custom Properties of the selected typeボタンをクリック
します。

次の図では、Numberカスタムプロパティが Duration HUD 要素に追加さ
れています。
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Numberカスタムプロパティが、Duration HUD 要素のプロパティに表示さ
れます 

ヘルプの「HUD要素のプロパティをカスタマイズする」のトピックを参照して
ください。

HUD 要素を削除する

Navigatorウィンドウで、HUD アセットの下の HUD 要素を削除することが
できます。HUD 要素を削除すると、そのすべてのプロパティも削除されます。

Navigatorウィンドウで、HUDアセットの下の HUD要素を削除するには

1 Navigatorウィンドウで HUD 要素を選択します。

2 右クリックして、コンテキストメニューから Deleteを選択します。

1 つまたは複数の HUD 要素をPropertiesペインから一時的に非表示にするに
は、その要素の上で右クリックし、 Remove Objectを選択します。
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ヘルプの「HUD要素を削除する」のトピックを参照してください。

HUD 要素を Profiling Center に表示する

HUD 要素を HUD アセットに追加する際、 HUD 要素のMotionBuilderのパ
フォーマンスに対する影響を把握していることが重要になります。これは、HUD
のパフォーマンスメトリックおよびその要素を Profiling Centerに表示する
ことで確認できます。

Profiling Centerで HUD およびその要素を表示するには

1 Windowメニューから、 Profiling Centerを選択します。

Profiling Centerウィンドウが表示されます。既定では、 Profiling
Centerには HUD およびその要素は表示されません。

2 Profiling Display Settingsペイン >  Display Details ドロップダウ
ンリストから、Renderingを選択します。

3 Profiling Display Settingsペイン >  Profiling Modeドロップダウ
ンリストから、Rendering Onlyを選択します。

4 Profiling Display Settingsペイン >  Evaluation Depth テキスト
ボックスをダブルクリックし、10 (評価深さの最大値)を入力します。

あるいは、マウスの左ボタンまたは右ボタンをクリックして、右にドラッ

グすることで評価深さの値を増やすこともできます。

Profiling Centerウインドウ A. HUDおよびその要素を表示する設定 B. HUDおよ
び追加された要素のタイプ

ヘッドアップディスプレイ | 53



ヒント: パフォーマンスの影響をミリ秒(ms)で表示するには、Profiling Display
Settingsペインの Frame Referenceチェックボックスをオフにします。

ヘルプの「HUD要素を Profiling Centerに表示する」のトピックを参照してく
ださい。

Display メニューのレガシー HUD

Heads Up Display Entryダイアログボックスの HUD 要素に加え、 Viewer
> Display > Head-up Display (HUD)メニューには、6 つのレガシー要素が
あります。

注:  Displayメニューからレガシー HUD 要素を選択すると、シーンに意図し
た情報が表示されますが、 Navigatorウィンドウの HUD アセットの下には表
示されません。したがって、 Displayメニューの HUD 要素には、位置、ス
ケーリング、またはフォント変更およびフォントのカラー変更を行うプロパティ

は含まれていません。

次の詳細については、リンク先を参照してください。

■ Display Rate、Display Memory Usage、Display Time Code、および Display
Safe Area: ヘルプの「Displayメニュー」のトピックを参照してください。

■ ViewCube: ヘルプの「ViewCube」のトピックを参照してください。

■ SteeringWheel: ヘルプの「SteeringWheels」のトピックを参照してくださ
い。

ヘルプの「DisplayメニューのレガシーHUD」のトピックを参照してください。
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覆い隠されたテクスチャジオメトリック要素を
Viewer ウィンドウで選択する

密なシーンのテクスチャジオメトリック要素を Viewerウィンドウで選択する
ことは、要素が他の要素によって覆い隠されている場合は特に難しく、時間も要

する場合があります。カメラビューを変更したり、 Navigatorウィンドウを
使用して、他の要素の背後にある要素にアクセスし、選択することもできます

が、特に大規模なシーンではきわめて非効率的です。

このリリースでは、次の機能によって、覆い隠されたテクスチャジオメトリッ

ク要素の選択が最適化されています。

■ 覆い隠されたテクスチャジオメトリック要素をアルファチャネルを使用し

て選択する

■ API を介し、アルファチャネルとセレクションオーバーライドカラーを使
用して、覆い隠されたテクスチャジオメトリック要素を選択する

MotionBuilderの SDK ヘルプ http://www.autodesk.com/motionbuilder-sdkdoc-
2013-enuを参照してください。

■ 部分的に透明なテクスチャを使用して、覆い隠されたテクスチャジオメト

リック要素を選択する

■ セレクションオーバーライドカラーを使用して、覆い隠されたテクスチャ

ジオメトリック要素を選択する

Viewer ウィンドウで覆い隠されたテクスチャジオメトリック要素の選択
および表示を行うためのキーボードショートカット

次の表では、 Viewerウィンドウでの覆い隠されたテクスチャジオメトリック
要素の選択および表示に関係するキーボードショートカットとユーザインタ

フェース(UI)要素について説明します。キーボードショートカットは、すべての
既定のカメラおよびカスタムカメラでサポートされています。
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注:  Viewerウィンドウ内の操作に関連付けられているキーボードショートカッ
トを使用するには、 Viewerウィンドウがアクティブになっている必要があり
ます。

状態/キーボードショート
カットの代替方法

UI要素キーボード
ショート
カット

操作

Rendererプロパティリソー
スの IDBufferPickingプロパ
ティを有効にします。

[Alt]+[Shift]+[A]
キー

EZ Selectionボタ
ンをオンにする。

Rendererプロパティリソー
スの IDBufferPickingプロパ
ティを無効にします。

[Alt]+[Shift]+[A]
キー

EZ Selectionボタ
ンをオフにする。

Rendererプロパティリソー
スの IDBufferDisplayプロパ
ティを有効にします。

IDBufferDisplay[Shift]+[A]
キー

テクスチャの透明

度しきい値を表示

する。

Rendererプロパティリソー
スの IDBufferPickingAlpha

IDBufferPickingAlpha[Shift]+[A]
キー +マウス
ホイールのス

クロール

テクスチャの透明

度しきい値を定義

する。 プロパティの値を調整しま

す。

Rendererプロパティリソー
スのSelectionOverrideプロ
パティを有効にします。

SelectionOverride[Alt]+[Shift]+[Q]
キー

覆い隠されたジオ

メトリック要素を

選択するためのセ

レクションオー

バーライドカラー

を有効にする。

Rendererプロパティリソー
スのSelectionOverrideプロ
パティを無効にします。

SelectionOverride[Alt]+[Shift]+[Q]
キー

覆い隠されたジオ

メトリック要素を

選択するためのセ

レクションオー

バーライドカラー

を無効にする。

56 | 第 1 章 新規機能と拡張機能



状態/キーボードショート
カットの代替方法

UI要素キーボード
ショート
カット

操作

Rendererプロパティリソー
スの

SelectionOverrideColorNone覆い隠されたジオ

メトリック要素を

SelectionOverrideColorプ選択するためのセ

ロパティフィールドまたはレクションオー

ボタンでセレクションオーバーライドカラー

を定義する。 バーライドカラーを定義し

ます。

Rendererプロパティリソー
スの

SelectionOverideTransparencyNone覆い隠されたジオ

メトリック要素を

SelectionOverrideTransparency選択するためのセ

プロパティの値を調整しま

す。

レクションオー

バーライドカラー

の透明度を定義す

る。

Rendererプロパティリソー
スの

Noneジオメトリッ

ク要素をク

セレクションオー

バーライドカラー

SelectionOverrideColorプリックし、のあるテクスチャ

ロパティフィールドまたは[Shift]+[1]
キー +マウス

ジオメトリック要

素を選択して循環

させる。

ボタンでセレクションオー

バーライドカラーを定義し

ます。

ホイールのス

クロール

Rendererプロパティリソー
スの

Noneジオメトリッ

ク要素をク

セレクションオー

バーライドカラー

SelectionOverrideColorプリックし、のあるテクスチャ

ロパティフィールドまたは[Shift]+[2]
キー +マウス

ジオメトリック要

素を循環させ、選 ボタンでセレクションオー

ホイールのス

クロール

択したジオメト

リック要素の前面

にあるジオメト

バーライドカラーを定義し

ます。

リック要素を非表

示にする。
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状態/キーボードショート
カットの代替方法

UI要素キーボード
ショート
カット

操作

Rendererプロパティリソー
スの

Noneジオメトリッ

ク要素をク

選択したテクス

チャジオメトリッ

SelectionOverrideColorプリックし、ク要素の前面にあ

ロパティフィールドまたは[Shift]+[2]
キー

る、セレクション

オーバーライドカ

ラーのあるテクス

ボタンでセレクションオー

バーライドカラーを定義し

ます。チャジオメトリッ

ク要素を非表示に

する。

Rendererプロパティリソー
スの

Noneジオメトリッ

ク要素をク

選択したテクス

チャジオメトリッ

SelectionOverrideColorプリックし、ク要素のみ表示す

る。 ロパティフィールドまたは

ボタンでセレクションオー

[Shift]+[3]
キー

バーライドカラーを定義し

ます。

Rendererプロパティリソー
スの

Noneジオメトリッ

ク要素をク

セレクションオー

バーライドカラー

SelectionOverrideColorプリックし、のある選択したテ

ロパティフィールドまたは[Shift]+[3]
キー +マウス

クスチャジオメト

リック要素を分離 ボタンでセレクションオー

ホイールのス

クロール

し、セレクション

オーバーライドカ

ラーのあるすべて

バーライドカラーを定義し

ます。

のジオメトリック

要素を(1つずつ)
スクロールする。
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覆い隠されたテクスチャジオメトリック要素

をアルファチャネルを使用して選択する

多くのジオメトリック要素が存在する密なシーンがあり、部分的に覆い隠された

バックグラウンドのジオメトリック要素を選択する必要がある場合は、フォアグ

ラウンドの部分的に透明なテクスチャジオメトリック要素のアルファチャネル

を使用して、バックグラウンドの要素を選択することができます。それには、

Viewer ツールバーの Easy Selection ボタン( )を使用するか、キーボード

ショートカット([Alt]+[Shift]+[A]キー)を使用します。他のキーボードショー
トカットも組み合わせて使用すれば、選択プロセスを迅速化できます。

注:  Viewerウィンドウ内の操作に関連付けられているキーボードショートカッ
トを使用するには、 Viewerウィンドウがアクティブになっている必要があり
ます。

次の画像は、アルファチャネルが存在する部分的に透明なテクスチャ要素を示

しています。アルファチャネルは、ジオメトリック要素の太陽のシェイプをし

た中央部分です。
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Viewerウィンドウでアルファチャネルを使用して、覆い隠されたテクスチャジ
オメトリック要素を選択するには:

1 Viewer ツールバーの Easy Selection ボタン( )をクリックするか、

キーボードショートカット([Alt]+[Shift]+[A]キー)を使用して、Easy

Selection ボタン( )をオンにします。

2 Viewerウィンドウで、ジオメトリック要素を覆い隠しているフォアグラ
ウンドのテクスチャジオメトリック要素のアルファチャネルをクリックし

ます。
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フォアグラウンドのジオメトリック要素の背後にあるジオメトリック要素

が選択され、境界線がハイライトされます。
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Viewerウィンドウで複数のアルファチャネルを使用して、覆い隠されたテクス
チャジオメトリック要素を選択するには:

1 Viewer ツールバーの Easy Selection ボタン( )をクリックするか、

キーボードショートカット([Alt]+[Shift]+[A]キー)を使用して、Easy

Selection ボタン( )をオンにします。

2 Viewerウィンドウで、バックグラウンドのジオメトリック要素を覆い隠
しているフォアグラウンドのジオメトリック要素のアルファチャネルをク

リックします。
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バックグラウンドのジオメトリック要素が選択され、境界線がハイライト

されます。

覆い隠されたテクスチャジオメトリック要素を Viewer ウィンドウで選択する | 63



API を介し、アルファチャネルとセレクショ
ンオーバーライドカラーを使用して、覆い隠

されたテクスチャジオメトリック要素を選択

する

ハンドヘルドカメラなどの外部デバイスを介し、アルファチャネルまたはセレ

クションオーバーライドカラーと透明度を使用して、テクスチャジオメトリッ

ク要素を選択できます。これにより、アルファチャネルを使用して選択を行い、

使用するカメラを指定することができます。

MotionBuilderの SDK ヘルプ http://www.autodesk.com/motionbuilder-sdkdoc-
2013-enuを参照してください。
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部分的に透明なテクスチャを使用して、覆い

隠されたテクスチャジオメトリック要素を選

択する

覆い隠されたジオメトリック要素をアルファチャネルを使用して選択するのと

同じように、フォアグラウンドの部分的に透明なテクスチャジオメトリック要

素を使用して、バックグラウンドのジオメトリック要素を選択することができま

す。それには、Viewer ツールバーの Easy Selection ボタン( )またはキー

ボードショートカット([Alt]+[Shift]+[A]キー)を使用し、テクスチャの透明度
しきい値を指定します。

注:  Viewerウィンドウ内の操作に関連付けられているキーボードショートカッ
トを使用するには、 Viewerウィンドウがアクティブになっている必要があり
ます。

次の画像は、アルファチャネルが存在する部分的に透明なテクスチャ要素を示

しています。アルファチャネルは、ジオメトリック要素の太陽のシェイプをし

た中央部分です。

覆い隠されたテクスチャジオメトリック要素を Viewer ウィンドウで選択する | 65



重要: テクスチャのアルファチャネルと透明度を使用するには、透明度の設定タ
イプが No Transparency以外に設定されたシェーダ(Lightedシェーダなど)
がジオメトリック要素に存在している必要があります。

Viewerウィンドウを使用して、テクスチャの透明度しきい値を Viewerウィン
ドウに表示するには:

1 Viewer ツールバーの Easy Selection ボタン( )をクリックするか、

キーボードショートカット([Alt]+[Shift]+[A]キー)を使用して、Easy

Selection ボタン( )をオンにします。

2 Viewerウィンドウの任意の場所をクリックして、 Viewerウィンドウを
アクティブにします。

66 | 第 1 章 新規機能と拡張機能



3 [Shift]+[A]キーを押します。

次の図には、シーン内のすべてのジオメトリック要素のテクスチャの透明

度しきい値が表示されています。

Properties Resourcesウィンドウを使用して、テクスチャの透明度しきい値を
Viewerウィンドウに表示するには:

1 Navigatorウィンドウで、 System、Coreの順に展開し、Renderer
をクリックします。

覆い隠されたテクスチャジオメトリック要素を Viewer ウィンドウで選択する | 67



2 Resourcesウィンドウで、 Propertiesタブをクリックします。

Rendererのプロパティが表示されます。
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Rendererのプロパティリソース

3 Rendererの Propertiesで、IDBufferDisplayを有効にします。

ジオメトリック要素の部分的に透明なテクスチャを使用して、覆い隠されたジオ

メトリック要素を Viewerウィンドウで選択するには:

重要: 選択するジオメトリック要素を覆い隠しているジオメトリック要素に、部
分的に透明なテクスチャとアルファチャネルが存在している必要があります。

1 Viewer ツールバーの Easy Selection ボタン( )をクリックするか、

キーボードショートカット([Alt]+[Shift]+[A]キー)を使用して、Easy

Selection ボタン( )をオンにします。

2 Viewerウィンドウで、部分的に透明なテクスチャジオメトリック要素を
クリックします。

次の図では、最前面のジオメトリック要素が選択されています。

覆い隠されたテクスチャジオメトリック要素を Viewer ウィンドウで選択する | 69



選択されている要素は、境界線がハイライトされます。

3 [Shift]+[A]キーを押して、テクスチャの透明度しきい値を表示します
(Rendererの[IDBufferDisplayプロパティが有効になります)。

テクスチャの透明度しきい値は、Renderer の IDBufferPickingAlpha
プロパティフィールドに表示されます。次の図では、テクスチャの透明度

しきい値が 0.5 に設定されています。
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テクスチャの透明度しきい値は IDBufferPickingAlphaプロパティで指定されます

テクスチャの透明度しきい値を 0.5 に設定すると、覆い隠されたジオメト
リを選択するときにテクスチャの透明度の 50% が考慮されます。次の図
で結果を確認してください。

覆い隠されたテクスチャジオメトリック要素を Viewer ウィンドウで選択する | 71



4 [Shift]+[A]キーを押しながらマウスホイールをスクロールして、テクス
チャの透明度しきい値を変更します。

ヒント: テクスチャの透明度しきい値(ID バッファ)は、Renderer の
IDBufferPickingAlphaプロパティフィールドで調整できます。

次の図では、テクスチャの透明度しきい値が 1 に設定されています。した
がって、覆い隠されたジオメトリを選択する際のテクスチャの透明度は

100% になります。
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テクスチャの透明度しきい値を 1 に設定すると、部分的に透明なジオメト
リを使用して簡単に選択を行えるようになります。

IDBufferPickingAlphaプロパティにアクセスするには:

1 Navigatorウィンドウで、 System、Coreの順に展開し、Renderer
をクリックします。

覆い隠されたテクスチャジオメトリック要素を Viewer ウィンドウで選択する | 73



2 Resourcesウィンドウで、 Propertiesタブをクリックします。

Rendererのプロパティが表示されます。
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Rendererのプロパティリソース

セレクションオーバーライドカラーを使用し

て、覆い隠されたテクスチャジオメトリック

要素を選択する

覆い隠されたジオメトリック要素をアルファチャネルを使用して選択するのと

同じように、フォアグラウンドの部分的に透明なテクスチャジオメトリック要

素を使用して、バックグラウンドのジオメトリック要素を選択することができま

す。それには、Viewer ツールバーの Easy Selection ボタン( )またはキー

ボードショートカット([Alt]+[Shift]+[A]キー)を使用し、テクスチャのセレク
ションオーバーライドカラーを指定します。セレクションオーバーライドカ

ラーの設定では、カラーオーバーライドにテクスチャの拡散チャネルが使用さ

れます。

覆い隠されたテクスチャジオメトリック要素を Viewer ウィンドウで選択する | 75



次の画像は、アルファチャネルが存在する部分的に透明なテクスチャ要素を示

しています。アルファチャネルは、ジオメトリック要素の太陽のシェイプをし

た中央部分です。

76 | 第 1 章 新規機能と拡張機能



セレクションオーバーライドカラーを使用して、覆い隠されたテクスチャジオ

メトリック要素を Viewerウィンドウで選択するには:

重要: セレクションオーバーライドカラーを使用して、覆い隠されたジオメト
リックを選択するには、透明度の設定タイプが No Transparency以外に設定
されたシェーダ(Lightedシェーダなど)がテクスチャジオメトリック要素に存
在している必要があります。

1 Viewer ツールバーの Easy Selection ボタン( )をクリックするか、

キーボードショートカット([Alt]+[Shift]+[A]キー)を使用して、Easy

Selection ボタン( )をオンにします。

2 Navigatorウィンドウで、 System、Coreの順に展開し、Renderer
をクリックします。

覆い隠されたテクスチャジオメトリック要素を Viewer ウィンドウで選択する | 77



3 Resourcesウィンドウで、 Propertiesタブをクリックします。

Rendererのプロパティが表示されます。
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Rendererのプロパティリソース

4 Viewerウィンドウの何も表示されていない領域をクリックして、ウィン
ドウをアクティブにします。

5 [Alt]+[Shift]+[Q]キーを押します。

覆い隠されたテクスチャジオメトリック要素を Viewer ウィンドウで選択する | 79



Selection Override オプションが有効になります。Renderer の
SelectionOverrideプロパティが有効と表示されます。

注:  IDBufferPickingAlphaの値は 1 になっています。

6 (任意) [Shift]+[A]キーを押します。

次の図には、定義したテクスチャの透明度しきい値

(IDBufferPickingAlpha)に基づいた選択可能なジオメトリック要素が
表示されています。
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ヒント: 定義したテクスチャの透明度しきい値に基づいた選択可能なジオ
メトリック要素を確認するには、 Viewerウィンドウで選択ボックスをド
ラッグします。

7 Rendererのプロパティで、次のいずれかの方法を使用してセレクション
オーバーライドカラーのプロパティを定義します。

■ SelectionOverrideColorの R、G、Bの各フィールドをドラッグす
るか、R、G、Bの各フィールドをダブルクリックして値を入力する、

■ または、 SelectionOverrideColor の R、G、Bのボタン( )を

クリックして、Color ウィンドウでカラーを選択します。

SelectionOverrideColorのR、G、Bの各フィールドが更新されます。

覆い隠されたテクスチャジオメトリック要素を Viewer ウィンドウで選択する | 81



8 Rendererのプロパティで、 SelectionOverrideTransparencyプロ
パティをドラッグまたはダブルクリックして、セレクションオーバーライ

ドカラーの透明度を定義します。

9 Viewerウィンドウで、テクスチャジオメトリック要素をクリックしま
す。

セレクションオーバーライドカラーを設定すると、どのテクスチャジオ

メトリック要素が選択されているか、簡単に確認できるようになります。

次の図には、 Rendererの SelectionOverrideColorプロパティで定
義されたセレクションオーバーライドカラーが付いた選択されたジオメト

リが表示されています。
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見分けにくい種々の透明なテクスチャが付いたジオメトリック要素が含ま

れている密なシーンで作業を行う場合は、 Rendererの
SelectionOverrideColorプロパティを利用すれば、選択プロセスが最
適化されます。

セレクションオーバーライドカラーのあるテクスチャジオメトリック要素を選

択して循環させるには:

1 Viewer ツールバーの Easy Selection ボタン( )をクリックするか、

キーボードショートカット([Alt]+[Shift]+[A]キー)を使用して、Easy

Selection ボタン( )をオンにします。

2 Viewerウィンドウで、テクスチャジオメトリック要素をクリックしま
す。

3 [Shift]+[1]キーを押しながら、マウスホイールをスクロールします。

Z バッファを使用して、セレクションオーバーライドカラーが付いたテク
スチャジオメトリック要素が 1 つずつ選択されます。

選択したテクスチャジオメトリック要素の前面にある、セレクションオーバー

ライドカラーが付いたテクスチャジオメトリック要素を非表示にして、背面に

覆い隠されたテクスチャジオメトリック要素を Viewer ウィンドウで選択する | 83



ある(セレクションオーバーライドカラーが付いた)テクスチャジオメトリック

要素を循環させるには:

1 Viewer ツールバーの Easy Selection ボタン( )をクリックするか、

キーボードショートカット([Alt]+[Shift]+[A]キー)を使用して、Easy

Selection ボタン( )をオンにします。

2 Viewerウィンドウで、テクスチャジオメトリック要素をクリックしま
す。

3 [Shift]+[2]キーを押しながら、マウスホイールをスクロールします。

選択したジオメトリック要素の前面にあるテクスチャジオメトリック要素

が非表示になり、背面にあるジオメトリック要素が Z バッファを使用して
1 つずつ選択されます。

選択したテクスチャジオメトリック要素の前面にある、セレクションオーバー

ライドカラーのあるテクスチャジオメトリック要素を非表示にするには:

1 Viewer ツールバーの Easy Selection ボタン( )をクリックするか、

キーボードショートカット([Alt]+[Shift]+[A]キー)を使用して、Easy

Selection ボタン( )をオンにします。

2 Viewerウィンドウで、テクスチャジオメトリック要素をクリックし、
[Shift]+[2]キーを押します。

セレクションオーバーライドカラーが付いた選択されたジオメトリック要素だ

けを表示するには:

1 Viewer ツールバーの Easy Selection ボタン( )をクリックするか、

キーボードショートカット([Alt]+[Shift]+[A]キー)を使用して、Easy

Selection ボタン( )をオンにします。

2 Viewerウィンドウで、テクスチャジオメトリック要素をクリックし、
[Shift]+[3]キーを押します。
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セレクションオーバーライドカラーが付いた選択されたテクスチャジオメト

リック要素を分離し、セレクションオーバーライドカラーが付いたジオメトリッ

ク要素を(1つずつ)スクロールするには:

1 Viewer ツールバーの Easy Selection ボタン( )をクリックするか、

キーボードショートカット([Alt]+[Shift]+[A]キー)を使用して、Easy

Selection ボタン( )をオンにします。

2 Viewerウィンドウで、テクスチャジオメトリック要素をクリックし、
[Shift]+[3]キーを押しながらマウスホイールをスクロールします。

一時的なピボットシフト

オブジェクトのピボットは、バウンディングボックスの中心点となるのではな

く、オフセット位置になることがあります。これにより、オブジェクトの中心を

選択して、それを別の場所に移動することができなくなります。Temporary
Pivot Shiftツールを使用すると、オブジェクトのピボットを、オフセット位
置からバウンディングボックスの中心に一時的にシフトできます。

ピボットを元の位置から一時的にシフトする

このセクションでは、Temporary Pivot Shiftツールを使用して、オブジェ
クトのピボットをオフセット位置からその中心に移動する方法を例を挙げて説明

します。

次の図は、Viewer ウィンドウの駐車場のシーンを示しています。このシーンに
は、柱 B と C の間に駐車された車が表示されています。シーン内の各柱はオブ
ジェクトです。

一時的なピボットシフト | 85



Viewerウィンドウの駐車場シーンのカメラビュー A、B、C、D柱 E. Temporary Pivot
Shiftアイコン

次の図で、柱 B のピボットはその中心から少し離れてオフセットされています。
ピボットのオフセット位置は、通常のカメラビューでは見えません。実際のオ

フセット位置を表示するには、ピボットを見つけるまでシーンを回転する必要が

あります。

柱 Cのピボットを見つけるために回転された駐車場シーン A.ピボットモード B、C.間に
車が駐車されている柱 D.柱 Cのピボットのオフセット位置

仮想本番環境において、監督がすべての柱(A、B、CおよびD)をシーン上に直ち
に再配置しようとした場合、シーンを回転し、各柱のオフセット位置を見つけ、

それらを各柱の中心点にドラッグしてから再配置するのは時間がかかります。

これを避けるには

1 移動対象のオブジェクトを選択します。

2 Viewerウィンドウのツールバーから、Temporary Pivot Shiftアイ
コンをクリックします。
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ピボットは次の図に示すように、オフセット位置からオブジェクトのバウ

ンディングボックスの中心に移動します。

一時的なピボットの座標、およびオフセット位置と一時シフトをバウンディング

ボックスの中心へとつなぐラインが点線で示されています。これは、オフセット

ピボット位置からオブジェクトの中心へのシフトが一時的に過ぎないことを示し

ています。

ヒント: Viewerツールバーから Temporary Pivot Shiftツールをクリック
する代わりに、Alt + Shift + Wキーを押して通常のピボットモードと一時

的なピボットモードを切り替えることができます。

一時的なピボットモードでシーンの任意のオブジェクトを選択すると、それぞ

れのオブジェクトのピボットが、一時的にオフセット位置からバウンディング

ボックスの中心にシフトされます。そのため、柱をそれぞれ選択してシーン内の

希望の場所に移動することができます。
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駐車場シーン A、B、C、D後方に移動された柱 E. Temporary Pivot Shiftツールはアク
ティブ

既定では、一時的なピボットは Translation モード(T)のときに表示されます。
回転モードとスケーリングモードには、R キーおよび S キーをそれぞれ使用し
て変更することができます。

ピボットの移動、回転、およびスケーリングは、Resourcesウィンドウ >
Propertiesタブに一覧表示されたプロパティを使用して操作できます。

ヘルプの「座標変換ピボットプロパティ」を参照してください。

シーンは、Alt + Shift + Wキーが有効な状態で保存することができます。

シーンを再ロードすると、保存された設定が含まれています。

ヘルプの「ピボットを元の位置から一時的にシフトする」のトピックを参照して

ください。

拡張オーディオエンジン

仮想本番環境での撮影の間、オーディオがあると、俳優、監督、編集者はビジュ

アルのシーンがストーリーと同期していることを確認できます。拡張オーディオ

エンジンでは、複数のオーディオトラックを Storyウィンドウに追加して、そ
れらを再生することができます。テイクベースのアプローチでは、テイクは再生

するオーディオファイルの再生先と考えられます。したがって、1 つのオーディ
オファイルだけが 1 つのテイクに割り当てることができます。

拡張オーディオエンジンでは次のことが可能です。

■ ある時点での複数オーディオトラックのストレッチ

■ 16 ビットの .WAV、.MP3、および .BWFファイル形式の読み込み
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注: .MP3ファイルを読み込むには、Apple QuickTime プレーヤをインストー
ルする必要があります。

Broadcast Wave Format (BWF) は、European Broadcasting Union (EBU)
が Broadcast Audio Extension チャンクを追加した、Microsoft WAVE オー
ディオファイル形式に基づいています。オーディオデータに加え、BWF
ファイルにはすべてのブロードキャストアプリケーションに必要と考えられ

るメタデータが含まれてます。このオーディオ形式では、さまざまなコン

ピュータプラットフォームに基づく異なったブロードキャスト環境間および

機器間でオーディオマテリアルをシームレスに交換できます。

■ MotionBuilder SDK からの WAV ファイルの書き出し。

MotionBuilder SDKのヘルプを参照してください。

注: BWFファイルは書き出すことはできません。

■ 左、右、または両方のチャネルを選択したオーディオコンテンツの再生

■ オーディオをテイクにコンストレインする際のオーディオスピードのロック

ヘルプの「拡張オーディオ」を参照してください。

Story ウィンドウでアニメーションとオーディ
オの同期を確認する

仮想本番環境では、Storyウィンドウを使用してキャラクタアニメーショント
ラックおよびオーディオトラックを作成することができます。次に、オーディ

オトラックにクリップを挿入し、キャラクタアニメーションおよびオーディオ

トラックを同時に再生して、キャラクタアニメーションのビジュアルの動きが

オーディオとマッチしているかを確認できます。この処理の間、さまざまなオー

ディオ設定を使用して希望のオーディオ品質を実現できます。

ヘルプの「キャラクタクリップを作成する」および「オーディオクリップを作

成する」を参照してください。

ヒント: アニメーションおよびオーディオトラックを作成する前に、Storyウィ
ンドウのコンテキストメニューの Insertオプションを使用してフォルダを挿入
してください。フォルダは、トラックをまとめるのに役立ちます。

へルプの「Story コンテキストメニュー」を参照してください。
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Navigator ウィンドウからオーディオクリッ
プを追加する

オーディオクリップを Navigatorウィンドウから Storyウィンドウに追加する
には:

1 オーディオファイルをロードします。

オーディオファイルが、Navigatorウィンドウの Audioアセットの下
に表示されます 

次の図では、読み込まれたオーディオファイルが Take 001 に割り当てら
れています。複数のオーディオファイルを読み込んだ場合、各ファイルに

対して個々のテイクを割り当てる必要があります。

Navigatorウィンドウ A.オーディオファイル B.オーディオファイルが割り当てら
れるテイク

2 Windowメニューから、Add Navigatorを選択します。

2 つ目の Navigatorウィンドウが表示されます。

3 1 つ目の Navigatorウィンドウで、Storyタブをクリックします。

4 2 つ目の Navigatorウィンドウでオーディオファイルをクリックし、1
つ目のNavigatorウィンドウのStoryウィンドウで既に作成したAudio
Trackにドラッグアンドドロップします。
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2つのNavigatorウィンドウA. 1つ目のNavigatorウィンドウB. 2つ目のNavigator
ウィンドウ C.ドラッグアンドドロップされたオーディオクリップ D.トラックに
クリップを割り当てた後、テイク名は消える

ヘルプの「Navigator ウィンドウからオーディオクリップを追加する」のトピッ
クを参照してください。

詳細については、「」のトピックを参照してください。

オーディオ設定を理解する

オーディオ設定では、オーディオの速度の調整、左、右または両方のチャネルの

選択などを行います。オーディオ設定は、Navigatorウィンドウおよび
Resourcesウィンドウ > Properties タブに表示されます 
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Navigatorウィンドウの Audio Settingsで次のボタンをクリックします。
■ Play — オーディオコンテンツを再生します。

■ Stop — オーディオを停止します。

次の表では、Resources > Propertiesタブのオーディオ設定を説明します。

注: 括弧内に記載された設定名は、Navigator ウィンドウのAudio Settingsペ
インに表示される名前に対応しています。

説明オーディオ設定

オーディオファイルの読み込み元のパスPath

オーディオファイルの再生先のデバイス。

接続されたすべてのオーディオデバイスのリストから再生先

のデバイスを選択します。

Destination

ソースオーディオシーケンスに録音されたオーディオサン

プルの数と、オーディオファイルの開始フレーム。この情報

Src In Point

はタイムスタンプとして保存され、BWAVヘッダファイル
にのみ含まれ、WAVファイルには含まれません。
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説明オーディオ設定

ソースオーディオファイルの最終フレーム。Src End Point

ソースオーディオファイルに含まれるフレームの総数。

注: ソースオーディオファイルが記録されたときに、 Src In

Point、 Src End Point、および Src Duration のパラメータ

があります。したがって、これらのフィールドのデータは変

更できません。

Src Duration

選択された再生先(スピーカなどの出力デバイス)でオーディ

オが再生される開始フレーム。

Dst In

オーディオファイルの最終フレーム。Dst End

オーディオファイルの合計期間。

注: 開始および終了時間を指定してオーディオファイルを再

生するには、Dst In、Dst End、およびDst Durationの

値を変更してください。

Dst Duration

シャトルモードを有効にします。タイムラインの開始フレー

ムおよび終了フレームの間でオーディオを前後にシャトルで

きます。

オーディオを前後にシャトルするには、Jキーとマウスの左
ボタンを同時に押して、マウスを Timelineの左または右に

Scrubbing (Enable
Shuttle)

移動します。このオプションを使用すると、Speedの値を手
動で変更せずに、速度の上げ下げを行うことでオーディオを

聞くことができます。

各オーディオサンプルに対して記録される情報のビット数を

指定します。ビット(8、16、または 24)の深さは、オーディ
オサンプルの解像度および音質に直接対応します。

Type (Bits)

拡張オーディオエンジン | 93



説明オーディオ設定

毎秒のオーディオサンプル数を指定します。

注: Type および Rate 値は、オーディオファイルのヘッダ情

報の一部です。

Rate (Hz)

ソースオーディオがモノラル(1.0)ファイルであるか、ステレ
オ(2.0)ファイルであるかを指定します。

Channels

Leftまたは Right (モノラル)チャネルおよび Left +Right (デュ
アル) チャネルがサポートされています。Rightまたは Left

Use Channel

チャネルのみを選択した場合、選択されていないチャネルは

Navigatorウインドウでは薄い色で図示されます。

オーディオファイルを選び再生する場所を指定します。オー

ディオファイルを選択する場所として、DiskまたはMemory
を選択できます。

Access Mode (Media
Access)

オーディオファイルが割り当てられる現在のテイクを指定し

ます。オーディオファイルが多数あり、オーディオファイ

Take

ルごとに異なるテイクを割り当てる場合、Takeの値を変更
することができます。

Dst Inの値の変更を制限します。

注: このオプションをオンにすると、自動的に Lock Speed

オプションがオンになります。

Constrain Dst to Take

オーディオファイルの場所。Relative Path

サウンドが指定された条件下で特定のメディア内を移動する

速度。アニメーションシーンの遅い動き、または速い動きに

合わせてオーディオの速度を上げたり下げたりします。

このオプションを使用して、オーディオの速度を 0.01～ 10
まで調整することができます。つまり、元の速度(1.0)の 100

Speed

倍遅く、または 10倍速くオーディオを再生することができ
ます。
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詳細については、「」のトピックを参照してください。

オーディオファイルの相対パスを取得するには

1 ファイルメニューから、Save Asを選択します。

Save Asウィンドウが表示されます。

2 ファイルの名前を指定し、Saveをクリックします。

オーディオコンテンツを含むファイルを保存したパスが、Relative Path
フィールドに表示されます。この相対パスは、後にオーディオコンテンツ

を含むファイルを開く際に使用できます。

リタイムツール

FCurves ツールバーの Retime Toolでは、アニメーションでのキーの移動の
タイミングを速くしたり遅くしたりして調整できます。複数の Autodesk アプリ
ケーションを使用してパイプラインで作業しているアニメータは、Maya、3ds
Max、および Softimage を含む他のアプリケーションで同様のアニメーション
リタイミングツールを使用できます。

アニメーションのすべてのステージで共通のタスクは、動きのタイミングを変え

ることです。アニメーションのタイミングを微調整することは、アニメータに

とっては繰り返し、かつ時間のかかる作業です。そのため、アニメータは次のも

のを必要としています。

■ アニメーションにおいてキーの移動(遅くする、速くする)を操作する予測可

能な方法

■ 追加のクリーンアップ作業が不要な高品質カーブ

アニメーションでキーの移動をリタイムする

アニメーションでキーの移動をリタイムするには、FCurves ペインでリタイム
マーカーを作成し、それらをドラッグしてキーの移動のタイミングを調節するこ

とができます。

リタイムマーカーを作成するには

1 アニメーションのあるオブジェクトを選択します。
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2 FCurves エディタでチャネル(T、R、または S)を選択します。

3 FCurves ツールバーで をクリックします。

これにより、FCurves エディタの Retime モードがアクティブになります。

FCurvesエディタ A.リタイムツール C. Tおよび Rチャネルを選択

4 FCurves ペインでダブルクリックして、リタイムするアニメーションカー
ブのセグメントの周りにリタイムマーカーを追加します。

注: マーカーを再配置するか、1 点からすべてのアニメーションにリップ
ル効果を適用するには、1 つのマーカーを追加します。

追加された 1つのリタイムマーカー A.マーカーを再配置するタイムバー(細い上下
の部分) B.アニメーションをリタイムするハンドル(中央の太い部分)

5 マーカー間のタイムスパンをリタイムするには、2 つ以上のマーカーを追
加します。

たとえば次の図では、フレーム 5 と 20 に 2 つのマーカーが、これらの間
のアニメーションをリタイムするために追加されています。
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リタイムマーカー A.マーカー間の実線 B.削除アイコン

複数のリタイムマーカーがある場合、各マーカーのペアの間に実線が表示され

ます。これにより、マーカーのいずれかをドラッグすると、最初のマーカーと次

のマーカーとの間のキーに影響が及ぶことが示されます。2 つのリタイムマー
カーを遠くに離れるようにドラッグするとそれらの間の動きを遅くし、近づける

ようにドラッグすると速くします。

リタイムマーカーを削除するには、Deleteアイコンをクリックするか、マー
カー上の任意の場所をダブルクリックします。

マーカーをドラッグすると、Transport Controlsウィンドウのタイムライ
ン、および Viewerウインドウにロードされたシーンにある、アニメートされ
たオブジェクトのタイミングが変更されます。

ヒント: リタイムモードを終了するには、 をクリックします。

ヒント: リタイムモードで、FCurves グリッドを移動するには Shift キーを押し
ながらマウスをドラッグし、ビューを拡大および縮小するには Ctrl キーを押し
ながらマウスをスクロールし、複数のリタイムマーカーを選択するには Shift を
押したままリタイムマーカーを選択します。

2 つのマーカー間のタイムスパンをロックす
る

2 つのマーカー間のタイムスパンをロックして、セグメント内のカーブの形を
スケーリングまたは調整せずに、ある時点のセグメントを移動することができま

す。
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2つのマーカー間のタイムスパンをロックするには

1 2 つのマーカー間に表示される実線を右クリックします。

2 コンテキストメニューから、Lockを選択します。

Lockオプションをアクティブにすると、リタイムマーカーをドラッグしたと
きのセグメント内の FCurve の調整を無効にします。

アニメーションのセグメントのロックは、カーブの形を調整せずに、複数のキー

をまとめてリタイムする必要があるときに役立ちます。セグメントがロックされ

たら、マーカーをドラッグしてセグメント全体を新しい時間位置へシフトしま

す。

ヒント: セグメントをロック解除するには、実線の上で右クリックしてLockオ
プションをオフにします。

マーカーを最も近いフレームにスナップする

マーカーをドラッグするときに、これを最も近いフレームにスナップするか、最

後に移動した位置に留めるかを選択することができます。既定では、すべての

マーカーはそれぞれのマーカーに最も近いフレームにスナップされます。
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マーカーを最も近いフレームにスナップするには

1 2 つのマーカー間に表示される実線を右クリックします。

2 コンテキストメニューから Snap All Retime Markers on Frameの
選択を解除します。

スナップを無効にした場合、マーカーは作成したフレームと同じフレーム

に表示されます。

リタイムマーカーにキーを挿入する

リタイムマーカーの下に現在表示されているすべての選択されたチャネル上に

キーを挿入することができます。

リタイムマーカーにキーを挿入するには

1 マーカー上の任意の箇所を右クリックします。

2 Insert Keyを選択します。

注: リタイムモードでは、キーまたは FCurve を編集することはできませ
ん。

ヒント: リタイムモードで直前の 10 アクションを元に戻すには、Ctrl + Z
を押します。

ヘルプの「リタイムツール」を参照してください。

Video Out ウィンドウを使用する
ペインゼロウィンドウの非インタラクティブなコピーを呼び出すことができま

す。このコピーは、ペインゼロウィンドウのコピーをセカンダリのモニタに置

いて現在のシーンをウォッチし、MotionBuilderで他のタスクを続ける場合に
役立ちます。

ペインゼロウィンドウのコピーを呼び出すには

1 Navigatorウィンドウ > VideosフォルダのVideo Output 1をダブル
クリックします。
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右ペインにビデオ出力設定が表示されます。

2 Video Out Windowボタンをクリックします。

Video Out Windowが非アクティブモードのため、空白の画面で表示
されます。

注: または、 Windowメニュー> Video Out から Video Out Window
を呼び出します。

3 Onlineチェックボックスをオンにして、 Video Out Windowをアク
ティブにします。

Video Out WindowにViewerで表示されているものが表示されます。

MotionBuilderインタフェース A.ペインゼロウィンドウのコピーで再生している
ビデオ B. Viewerで再生しているビデオC. Video Output 1 D. Video Out Window
ボタン E. Onlineチェックボックス F. DrawModeプロパティ

既定では、Video設定および External Sync設定は無効になっていま
す。これらの設定は、MotionBuilderで Nvidia SDI Output カードを使用
している場合にのみ有効になります。

重要: Video Out Windowを使用すると、シーンのフレームレートに影響が
及ぶ場合があります。さらに、Video Out Windowにサイズの大きいファイ
ルをロードすると、MotionBuilderのパフォーマンスにも影響が及ぶ場合もあ
ります。
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ヒント: フレームレートへの影響を最小限に抑えるには、 Resourcesウィンド
ウ> Properties タブ > Video Output 1 > DrawMode プロパティのドロッ
プダウンリストから、 Output onlyを選択します。

ヘルプの「Video Outウィンドウを使用する」を参照してください。

Story ウィンドウのサマリークリップ
Storyウィンドウでは、複数のトラックを挿入し、各トラックにオーディオ、
アニメーション、またはビデオクリップを追加することができます。フォルダ

を挿入し、その中で複数のトラックをグループ化できます。フォルダ内にクリッ

プがたくさんある場合、タイムラインに沿って各クリップを選択したり移動する

には時間がかかります。これを避けるため、 Storyツールバーの Summary
Clips On/Offウィンドウを使用して、サマリークリップをフォルダトラック
の一部として表示することができます。サマリークリップを移動すると、フォ

ルダ内のすべてのクリップを移動できます。

サマリークリップを表示するには、 Storyツールバーから Summary Clips
On/Offアイコンをクリックします。サマリークリップがフォルダ内のすべて
のクリップの先頭に表示されます 
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Storyウィンドウ A. Summary Clips On/Offアイコン、B.サマリークリップ、C.フォル
ダ、D.フォルダ内のトラックおよびクリップ

注: 既定のサマリークリップの長さは、フォルダ内の最も長いクリップのタイム
ラインと同じです。

サマリークリップを使用して次のことができます。

■ タイムラインに沿ってフォルダ内のすべてのクリップをドラッグする。

■ ある時点のサマリークリップをスケーリングする。サマリークリップをス

ケーリングすると、フォルダ内のすべてのクリップもそれに従ってある時点

でスケーリングされます。サマリークリップをスケーリングするには、Story

ツールバーの Loop/Scale Clipsアイコン( )をクリックして、ス

ケールモードをオンにします( )。

注: 現時点では、すべてのクリップをスケーリングするだけで、ループする
ことはできません。

■ 現在のトランスポートコントロールタイムに沿って配置されているフォル

ダ内の 1 つまたはすべてのクリップを分割する。これを行うには、サマリー
クリップを選択し、クリップを分割する位置までタイムラインを移動します。

Storyツールバーから Razorアイコンをクリックします。
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StoryウィンドウA. Razorアイコン、B.クリップが分割されるタイムラインの位置、
C.分割されていないサマリークリップ

注: Razorツールは、フォルダ内のクリップのみを分割します。サマリーク
リップには影響はありません。

ヒント: Storyウィンドウで行われた操作を元に戻すには、[Ctrl]+[Z]を

押します。

サマリークリップの名前は、フォルダトラックの名前と同じです。フォルダト

ラックおよびサマリークリップの両方の名前を変更するには、フォルダトラッ

クまたはサマリークリップの上で右クリックし、コンテキストメニューから

Renameを選択します。サマリークリップの名前は、フォルダを最小化したと
きに、フォルダの概要を知る際に役立ちます。

StoryウィンドウA.サマリークリップとフォルダの名前は同じ、B.最小化されているフォ
ルダ

サマリークリップを削除すると、フォルダおよびフォルダ内のクリップも削除

されます。サマリークリップを削除するには、サマリークリップ上で右クリッ

クし、コンテキストメニューから Deleteを選択します。
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ヘルプの「トラックのサマリークリップを追加する」のトピックを参照してく

ださい。

Story ウィンドウでトラックの選択的表示
多くのキャラクタを含む次のシーンを考えてみましょう。この Story ウィンドウ
では、シーンの各キャラクタがアニメーショントラックで表現され、すべての

トラックの名前が似ています。キャラクタのタイミングを操作する場合、 Story
ウィンドウ内でその特定のキャラクタに対するアニメーショントラックを探す

のは困難です。
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Viewerウィンドウと StoryウィンドウA.多くのキャラクタが登場するプレイグラウンド
シーン、B.同様の名前の付いたアニメーショントラック、C. Filter by selectionツール
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Filtering by selection

Filtering by selection ( )ツールは、シーンで選択したオブジェクト

に属するアニメーショントラックのみを表示します。

選択されたオブジェクトのみに属するトラックを表示するには

1 シーンからオブジェクト(複数も可)を選択します。

たとえば、次の図では 1 つのアニメーションキャラクタが選択されていま
す。

2 Storyツールバーから、Filter by selectionアイコンを選択します。

Viewerウィンドウと Storyウィンドウ A.選択されたキャラクタ、B.選択された
キャラクタのアニメーショントラック、C. Filtering by selectionアイコン、D.選
択されたオブジェクトのトラックのみが表示されていることを通知するメッセージ

必要に応じて、選択したキャラクタのタイミングを操作します。
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注: Filtering by selectionツールがアクティブのときは、 Storyウィ
ンドウのバックグラウンドカラーは青色になります。

Lock filtering by selection

オブジェクトの挿入など、シーンで追加のタスクを実行する場合、 Storyウィ
ンドウでビューをロックすることが重要です。これを行うには、Lock filtering

by selection ( )ツールをクリックします。

注: Lock filtering by selectionアイコンは、Filtering by selectionアイ
コンがアクティブの場合にのみ有効です。

Viewerウィンドウと StoryウィンドウA. Lock filtering by selectionアイコンがアクティ
ブ、B.すべてのキャラクタの現在の位置は変更されていない、C.選択済のキャラクタの
トラックの位置はStoryタイムラインで変更されていない、D.シーンにオブジェクトを追
加、E.ロック状態を表示している Storyウィンドウ

キャラクタをロック解除し、タイミングを操作するには、Filtering by
selectionアイコンをクリックします。

注: Lock filtering by selectionツールがアクティブのときは、 Storyウィ
ンドウのバックグラウンドカラーは黄色になります。
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ヘルプの「選択したトラックだけを表示する」を参照してください。

Story ウィンドウのトラック記録オプション

Story のトラックには、トラックの Recording optionsボタン( )および

Recording Optionsメニュー( )があります。

Animation Track Recording optionsダイアログを表示するには、 Record

Options ( )オプションをクリックします。

Storyウィンドウ A. Record Optionsメニュー、B. Recording Optionsメニュー

Story ウィンドウのAnimation Track、Character Track、またはCamera

Animation Trackで Recording optionsボタン( )をクリックすると、

そのトラックのTrack Recording optionsウィンドウが表示されます。Track
Recording options ウィンドウの Always displayチェックボックスは既定で
オンになっています。このチェックボックスをオフにすると、次のセッションか

ら Recording optionsボタンをクリックして Animation Track Recording
optionsウィンドウを呼び出せなくなります。
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Animation Track Recording optionsウィンドウ A. Always displayチェックボックスは
既定でオン

Track Recording options ダイアログとは異なり、Properties ウィンドウには、
すべてのトラック記録オプションが含まれます。

ヘルプの「Storyトラックをメモリまたはディスクに記録する」トピックを参照
してください。

Story トラックをメモリまたはディスクに記録
する

MotionBuilder により、ライブシーンの表示、ソースデータのメモリへの記
録、およびソースデータのディスクへの記録が可能になります。ディスクへの

記録機能は、システムのメモリ制限を容易に上回ることのあるきわめて大きい

シーンファイルを扱うときに、重要になります。データをメモリバッファに格

納する代わりに、リアルタイムでデータをディスクに保存できます。また、個

別の Animation トラック、Character トラック、Camera トラッククリップの
各ファイルをディスクに記録することもできます。

既定ではトラックの記録先はメモリに設定されていますが、メモリではなくディ

スクに記録することの利点は、特に大規模なシーンファイルを使用している場

合やモーションキャプチャデータを扱っている場合にはるかに大きくなります。

記録を開始する前に、Story の記録、クリップ、およびトラックのプリファレン
スが必要に応じて設定されていることを確認してください。

Storyプリファレンス設定にアクセスするには:

1 メニューバーで Settings > Preferences を選択します。
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2 Preferences ウィンドウで Story プリファレンスオプションをクリックし
ます。

Story プリファレンス設定が表示されます。

Storyプリファレンス

データを記録するときに、Story ウィンドウで次を指定する必要があります。

■ 記録するトラック、

■ トラックの Recording オプション、

■ メモリ、またはディスクのいずれに記録するか。

API によって Story トラックを記録する

トラックのブーリアン値を記録する機能を true に設定できます。トラック、ま
たは Story の記録に対する値をパスに入力することができます。この場合、パス
はすでに存在していなければなりません。
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次の標準文字列フォーマットを使用してクリップの命名規則を入力できます。

Python : Track.ClipNameConvention = %s_%s %(Track.Name,
Track.ClipNumber)

クリップを作成した後、コールバックを受け取ることができます。

MotionBuilderの SDKヘルプhttp://www.autodesk.com/motionbuilder-sdkdoc-
2013-enuを参照してください。

Story フォルダと Story トラックの記録パス

記録を開始する前に、Story フォルダと Story トラックの記録パスを設定する必
要があります。フォルダ内のトラックを除き、記録したいトラックごとに記録パ

スを定義する必要があります。たとえば、Story ウィンドウ内のフォルダに対す
るパスを設定して、このフォルダ内のトラックがすべて同じパスを指すように設

定できます。また Story ウィンドウ内のフォルダに対するパスを設定し、さらに
このフォルダ内のトラックに対する別のパスを設定することもできます。これ

は、ネストしたフォルダとトラックにも適用されます。完全な下位のパスによ

り、上位のパスは上書きされます。一方、パスが不完全な場合、階層構造は、完

全なパスを形成するようにアセンブルされます。これにより、フォルダにはベー

スパスを保持した状態で、トラック内のサブフォルダだけを指定できるように

なります。

Storyフォルダの記録パスを設定するには:

1 Story ウィンドウでフォルダをダブルクリックして、Resources ウィンドウ
にプロパティを表示します。
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表示の Storyフォルダが選択された状態

Story トラックとは異なり、Story フォルダには、記録パスを定義する

Recording options ( )や Recording Optionsメニュー( )

はありません。

2 Resources ウィンドウの Properties で選択したフォルダを展開してその内
容を表示します。
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全 Story フォルダの記録パスが Property Resources ウィンドウで設定され
ます。

3 をクリックします。

4 Open Directory ウィンドウで、記録のパスを選択し、OK をクリックしま
す。

記録パスが設定され、 RecordClipPathフィールドに表示されます。

Storyトラックの記録パスを設定するには:

注: トラックの記録パスは、Property Resources ウィンドウ(Story フォルダの場
合と同じように)、Story ウィンドウにある Story トラックの  Recording

options ( )、または Recording Optionsメニュー( )を使用して

設定できます。

1 Story ウィンドウで、記録したい Story トラックをクリックします。

2 Story ウィンドウで、Story トラックの Recording options ( )、ま

たは Recording Optionsメニュー( )をクリックし、次に

Recording options メニュー( )をクリックし

ます。

選択されたトラックの Recording options ウィンドウが表示されます。
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トラックの Recording option ダイアログに表示されるプロパティはアニ
メート可能で、記録できるプロパティです。

前の図に示すアクティブ化された既定の記録プロパティ( )は、

Translation と Rotation のプロパティです。

3 記録したいプロパティをアクティブ化します。

4 をクリックします。

5 Open Directory ウィンドウで、記録のパスを選択し、OK をクリックしま
す。
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ヒント: Recording Path フィールドにパスを入力し OK をクリックするこ
とで、記録パスを設定することもできます。

データをディスクに記録する

ディスクに記録することにより次のことが可能になります。(a)テイクを停止し
てメモリを解放することなく、多数のタスクを記録できる、(b)リアルタイム
セッションで記録できる、(c) mocap ソースを介して効果的にアニメーションを
アグリゲートできる、(d)シーンを最初から再構築するのではなく、記録済みの
シーンを開いて、作業を続行できる。

キャプチャするデータをディレクタのカメラに映るものだけに限定できます(た

だし場合によって、ディレクタはアクターが記録されているときにカメラの撮影

を避けることがあります - 後で使用できるように、単にアニメーションアセッ
トを集めている場合などです)。

たとえば、モーションキャプチャのマーカーごとに動かされるキャラクタを表

示するモーションキャプチャデータや、コンストレインされたカメラを動かす

スケルトンおよびマーカーデータを伴うシーンがある場合(下図の一番上にある

Viewer ペインに示すとおり)、モーションキャプチャデータを記録することが
できます。ただし本当に記録が必要なのは、最終結果、すなわちカメラに記録す

るデータ、およびリターゲットされたキャラクタに記録するデータだけです。下

の図の下方の Viewer ペインには、ディレクタのカメラに表示される内容を示し
ます。
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データをディスクに記録するときは、次を指定する必要があります。

■ データを記録する場所

事例: すべてのトラックについて同じトラック記録パスを定義します。

■ トークンの命名規則(ClipNameConvention)

既定の命名規則は次のとおりです。

<Name>_<StartDate>_<StartTime>

個々のテイクに固有の名前が必要です。トークンはカスタマイズできます。ト

ラック名、Timecode、開始時間、終了時間、テイク名、およびスタティックテ
キストを追加できます。トラックの記録に使用するトークンを定義する目的は、

記録ファイルの管理を最適化することにあります。
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次のキーを使用してクリップに対する命名規則を定義できます。

■ <Name> 現在のトラックの Name プロパティ

■ <TakeName> システムの現在のテイク名

■ <StartTCValue> Transport Controls のレートの時間ベースを使用した
Timecode 値

■ <StartFrameValue> Transport Controls に基づくフレーム値

■ <StartDate> 現在の日付(ISO 8601 国際標準に基づく YYYY-MM-DD)

■ <StartTime> 現在の時刻(ISO 8601 国際標準に基づく HHMMSS)

任意の英数の文字列値(特殊文字を除く)を入力することもできます。クリップ名

の一意性を保持するために反復値を使用しない場合、現在のクリップが新しいク

リップで上書きされます。

Storyトラックをディスクに記録するには:

1 記録オプションがメモリ( )に設定されている場合は、Story コント
ロールで Record to memory/disk オプションをクリックします。Record

to memory/disk オプションが Record to disk ( )に設定されている

場合は、次の手順に進みます。

注: Record to memory/disk オプションは、既定でメモリ( )に設定

されています。

2 Story コントロールで、記録するトラックを選択します。

3 Story ウィンドウ、または Property Resources ウィンドウのいずれかでト
ラックの記録に使用するパスを設定します。

「Story トラックの記録パスを設定するには(113ページ)」、および「Story
フォルダの記録パスを設定するには(111ページ)」の手順を参照してくださ
い。

4 Story ウィンドウで、選択したトラックの Recording optionsボタン(

)をクリックします。

記録パスが設定されると、選択したトラックの Recording optionsボ

タン( )の輪郭が灰色から緑( )に変わります。
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トラックの Recording options ダイアログには、記録パス、およびトラッ
ク記録オプションに加えたその他の変更が表示されます。

5 トラックの Recording options ダイアログで OK をクリックします。

6 (オプション)トラックの記録パスを確認するには、Property Resources ウィ
ンドウでトラックを展開し、Recording プロパティを展開して、内容を表
示します。

RecordClipPathフィールドには、トラックの記録パスが表示されます。

注:  RecordToTrackの Recording プロパティを有効にすることにより、
Property Resources で記録を設定することができます。

7 Transport Controls で Record ( )をクリックします。
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Transport Controls の Record ボタンが赤( )に変わり、これが記

録状態であることを示します。Story ウィンドウの Record Mode ボタン(

)が緑( )に変わります。

8 Transport Controlsで、Play ( )をクリックし、記録を開始します。

Story ウィンドウで Record Mode ボタンが赤( )になり、データが記

録中であることを示します。

ディスクに記録すると、トラックの内容(ボーンなど)を含む .fbxファイル
のテンプレートが作成されます。記録が終了すると、.fbxファイルテンプ
レート、および記録されたトラックのアニメーションが .fbxファイルに
マージされます。

注: MotionBuilderでは FBX に直接記録することができないため、.fbx
ファイルテンプレートが作成されます。

使用するモーションキャプチャの例では、モーションキャプチャシステ

ムにライブ接続されてはいませんが、ライブコンストレインが記録されま

す。リターゲットキャラクタまたはカメラに実際のデータはありません。

MotionBuilderが、記録の実行時にこのデータをディスクに書き込みま
す。

Story トラックは、記録されたデータを表しています。記録されたデータ
が 3D 記録のEditorial タイムラインに挿入されます。オブジェクトを操作
すると、アニメーションが記録されます。

記録されたデータを表す Storyトラック
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トラックには、定義したトークンの命名規則が表示されます。

<Name> <StartTCValue> <StartFrameValue> <StartDate>
<StartTime> <TakeName>

9 Transport Controls で Stop ( )をクリックします。

注: 記録は必要に応じて、停止させたり、続行させたりできます。

Story ウィンドウのトラックが灰色になり、ディスクに記録されたトラッ
クであることを表します。実際は、そのトラックはアンロードされていま

す。

記録の後、記録されたトラックをアンロードせず、ロードさせておきたい

場合は、Story の記録プリファレンスを変更する必要があります。

ディスクに記録した Storyトラックを Storyウィンドウに再ロードするには:

■ Story ウィンドウで、再ロードする Story トラックを右クリックし、コンテ
キストメニューから Load/Unload > Load Clips を選択します。

次の図は、再ロードする Story トラックが選択された状態を示しています。

記録された Story トラックが Story ウィンドウにロードされ、トラックを編
集することができます。Story トラックが灰色ではなくなり、ロードされて
いることを表します。
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注: 記録が終了した後、クリップをアンロードまたはロードするように、記録プ
リファレンスを設定できます。記録が終了した後にクリップをロードするように

設定すると、ロードの終了と同時にクリップを使用できるようになります。記録

の間にクリップをアンロードするように設定すると、記録のパフォーマンスに影

響を与えることなく、クリップを順次記録することができます。

MotionBuilderヘルプにある「Storyプリファレンス」トピックを参照してくだ
さい。

現在のクリップにトラックを記録するには:

1 Story ウィンドウで新しいクリップの開始時刻を設定します。

2 Transport Controls で Record ( )をクリックします。

現在のクリップに新しいクリップが上書きされますが、最初から最後まで

上書きされるとは限りません。現在のクリップの部分で、終了時刻が新し

いクリップの開始時刻と同じである部分が、新しいクリップで上書きされ

ます。元のクリップのデータはまだ存在します。元のクリップの表示だけ

が変更されます。

データをメモリへ記録する

シーンファイルのサイズが小さく、記録結果をただちに見たい場合、またはメ

モリ容量について心配する必要がない場合は、メモリに記録しても、ディスクに

記録して再度メモリにロードしてもかまいません。
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Story トラックをメモリに記録する手順は、Story トラックをディスクに記録す

る手順とほぼ同様です。Record to disk ( )オプションではなく、Record

to memory ( )オプションを選択します。

現在のクリップにトラックを記録するには:

1 Story ウィンドウで新しいクリップの開始時刻を設定します。

2 Transport Controls で Record ( )をクリックします。

現在のクリップに新しいクリップが上書きされますが、最初から最後まで

上書きされるとは限りません。現在のクリップの部分で、終了時刻が新し

いクリップの開始時刻と同じである部分が、新しいクリップで上書きされ

ます。

この手順は、ディスクに記録された Story トラックにも有効です。

Storyトラックをメモリに記録するには:

1 Story ウィンドウで、記録するトラックを選択します。

Video Settings でイメージシーケンスのフレー
ムレートをカスタマイズする

MotionBuilderにイメージシーケンスを読み込むとき、既定ではシステムのフ
レームレート(Transport Controls ウィンドウで選択)を使用してイメージシー
ケンスを再生します。Transport Controlsのフレームレートを変更すると、
イメージのシーケンスに対しても新しいフレームレートが適用されます。

本リリースでは、Use system frame rateオプションがチェックボックスと
して用意され、既定ではオンになっています。このオプションでは次のことが可

能です。

■ ドロップダウンリストから他のフレームレートを選択する

■ 独自のフレームレートを入力する

■ Transport Controlsウィンドウに設定したフレームレートと同じフレー
ムレートを使用する
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注:  Use system frame rateオプションは、 Image sequenceオプション
を選択した場合にのみアクティブになります。このオプションを選択しないと、

Use system frame rateオプションは無効となり、Transport Controlsの
フレームレートを参照します。

Transport Controlsのすべてのフレームレートは、 TimeModeドロップ
ダウンリストからも使用できます。

イメージをシーケンスで再生するフレームレートを入力するには

1 TimeModeドロップダウンリストから、 Customを選択します。

Custom Frame Rateダイアログボックスが表示されます。

2 Insert new frame rateテキストボックスに希望のフレームレートを
入力します。

Transport Controlsウィンドウと Video Settingsタブ A. Image sequenceチェッ
クボックス B.カスタムのフレームレート(10 fps) C. Transport Controlsウィンド
ウのフレームレート

ヒント: マウスの左または右ボタンを押してこのテキストボックスをドラッ
グして、フレームレートを上げたり下げたりします。
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ヒント:  Resourcesウィンドウ > Propertiesタブ >  TimeModeドロップ
ダウンリストから Customを選択して、FrameRateテキストボックスにフ
レームレートを入力することもできます。

ヘルプの「イメージをシーケンスで再生するフレームレートをカスタマイズす

る」を参照してください。

ロールボーンの拡張機能

MotionBuilderの過去のリリースでは、キャラクタの手足を回転するときに、
ロールボーンの動作のコントロールに制限がありました。これは、Maya と
MotionBuilder両方での HumanIK 実装に関するユーザビリティの問題でした。
さらに、プロパティを示す用語およびプロパティを表示する方法もユーザに混乱

を招いていました。

今回、Maya およびMotionBuilderの両方に新しい HIK 4.5 Character Solver
が実装されています。このソルバには、このユーザビリティの問題を解決する、

すべての必要なロールボーンプロパティが含まれています。これで、プロパティ

を簡単に使用できるようになり、ユーザはどのボーンが特定の手足に対してどの

程度影響を及ぼすかを決定することができます。たとえば、前腕のロールへの影

響は 40%、肘は 0% などにできます。
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Maya とMotionBuilderで一貫性をもたせるために、プロパティの名前も変更
されています。古いロールボーンプロパティ名とそれに対応する新しい名称を

次の表に示します。

新しいロールボーンプロパティ名古いロールボーンプロパティ名

Left Forearm RollLeftForeArmRollEx

Left Elbow RollLeft ForeArm Roll

Left Arm RollLeftArmRollEx

Left Shoulder RollLeft Arm Roll

Right Forearm RollRightForeArmRollEx

Right Elbow RollRightForeArm Roll

Right Arm RollRightArmRollEx

Right Shoulder RollRight Arm Roll

Left Leg RollLeftLegRollEx

Left Knee RollLeft Leg Roll

Left UpLeg RollLeftUpLegRollEx

Left Hip RollLeft UpLeg Roll

Right Leg RollRightLegRollEx

Right Knee RollRight Leg Roll

Right UpLeg RollRightUpLegRollEx

Right Hip RollRight UpLeg Roll
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注: 新しい値には、既定で肘および肩へのロールの影響は含まれていません。

新しいロールボーンプロパティとその値

新しい値には、既定で肘および肩へのロールの影響は含まれていません。

プロパティ値について、ロールボーンの値(Left Forearm Roll)は、対応する <ペ
アレント> ロール値(Left Elbow Roll)よりも高くすることはできません。ロール
ボーンでは対応する肘よりも多くは抽出できず、それよりも少なくのみ抽出でき

ます。同じことが肩および足のロール値にも当てはまります。

ロールボーンがない、または定義されていない場合、対応するロールボーンプ

ロパティは無効(編集不可)になり、残りのロールプロパティは対応するペアレン

ト(Elbow、Shoulder、UpLeg、および Knee)に適用されます。

ロール量は、Roll Extraction Modeで定義されます。抽出モードは以下の 2
つです。

■ Relative — HIK 生成のロール量を処理します。

■ Absolute — ユーザ生成および HIK 生成の両方のロール量を処理します。

ヘルプの「モディファイヤ」を参照してください。
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その他の変更点

ここでは、MotionBuilderソフトウェア製品の、このリリースでのその他の変更点に
ついて説明します。

ヘルプトピックを共有する

このリリースのMotionBuilderヘルプでは、トピックページの右上に共有
UI ボタンがあり、既定の電子メールアプリケーションからヘルプトピックにリ
ンクを送信することができます。

ヘルプのトピックを共有するには:

1 ヘルプ内の、共有するトピックのページに進みます。

2 トピックページの右上で をクリックします。

既定の電子メールアプリケーションが起動します。電子メールのタイトルに

トピックが含められ、本文にはそのトピックへのリンクが含められます。

解像度に依存しない Editing レイアウト
Scripting レイアウト、Preview レイアウト、およびカスタムレイアウトとは異な
り、Editing レイアウトでは画面解像度に関係なく一貫性が維持されます。した
がって、すべてのシステムで同一の Editing レイアウトを利用できます。

ヘルプの「レイアウト」を参照してください。

2
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Profiling Center ウィンドウ
Evaluation > Parallel Evaluationドロップダウンリストでは次の変更が
あります。

■ Parallel Simpleオプションは削除されています。

■ Parallel Advancedオプションは、名称が Parallelに変わっています。

Reset to Default ボタンがなくなり、ユーザの設定をより詳細にコントロールで
きる次の 3 つのボタンが追加されています。
■ Save User Settings

■ Reset User Settings

■ Restore Default Settings

ヘルプの「Profiling Centerウィンドウ」を参照してください。

FCurves ウィンドウ

FCurves ツールバーに、新しい Retime Tool ( )アイコンが追加されまし

た。ヘルプの「リタイムツール」を参照してください。

FCurves コンテキストメニューの次のメニューの名前が変更されています。

■ Display から View へ

■ Snap から Edit へ

■ Extrapolation から Pre/Post Extrapolation へ

さらに、

■ メインメニューからは、Cut、Copy、および Paste オプションが削除されて
います。

■ Edit メニューに、Copy および Paste の 2 つのサブオプションが追加されて
います。
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ヘルプの「FCurve コンテキストメニュー」を参照してください。

ストーリートラックのネームスペースのサポー
ト

本リリースでは、オブジェクト名のネームスペースを対応するストーリートラッ

クに追加できます。これを可能にするために、Add/Remove Namespaceオ
プションがStoryツールコンテキストメニューに追加されています。このコン
テキストメニューオプションをクリックすると、シーンオブジェクトに追加さ

れたすべてのネームスペースを含む Add/Remove Namespaceダイアログ
ボックスが表示されます 
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ストーリートラックにネームスペースを追加するには

1 Storyツールから 1 つまたは複数のストーリートラックを選択し、その
上で右クリックして Add/Remove Namespaceコンテキストメニュー
オプションを選択します。

Add/Remove Namespaceダイアログボックスが表示されます。既定
では、Addタブに、オブジェクト名に追加されたすべてのネームスペース
が表示されます 

2 Current Namespaces in Sceneリストボックスからネームスペースを
選択し、Okをクリックします。

選択されたストーリートラックの名前の先頭にネームスペースが追加され

ます。
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ヒント: Navigatorウィンドウのオブジェクトおよび Storyツールのス
トーリートラックで実行したネームスペース操作を元に戻すには、Ctrl +
Zキーを押します。

オブジェクトのすべてのネームスペースが Navigator > Namespaces
フォルダ内に表示されています。

ネームスペースを別のネームスペースに置き換えたり、ストーリートラックか

らネームスペースを削除するには、ヘルプの「ネームスペース」に記載の手順に

従ってください。
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Viewer ウィンドウを更新する
Viewerにアニメーションシーンを表示することを考えてみましょう。たとえ
ば Windows エクスプローラーなどの別のアプリケーションを開くと、Viewer
の上で開かれます。ここで Windows エクスプローラーがアクティブのウィンド
ウになり、Viewerウィンドウは非アクティブになります。これにより、Viewer
のアニメーションシーンの再生が停止し、アイドル状態が保たれます。これを

アクティブにして再生を再開するには、Viewerにフォーカスを戻す必要があ
ります。

仮想本番環境では、さまざまなアプリケーションで作業しているときに、Viewer
が自動的にリフレッシュされることが重要です。これを実現するには、Profiling
Centerウィンドウの Always refresh viewerチェックボックスをオンにし
ます。このチェックボックスをオンにすると、特定のセッションのみに対して

Viewerウィンドウを常にアクティブ状態にします。

Always refresh viewerチェックボックスを永続的にオンにするには、
Profiling Center] の Save User Settingsボタンをクリックします。これ
で、MotionBuilderの構成に設定が保存されます。

Profiling Center A. Always refresh viewerチェックボックス B. Save User Settingsボ
タン

ヘルプの「Profiling Centerウィンドウ」を参照してください。
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Video Settings
Video Settings ウィンドウで、システムフレームレートを表示する FPS static
テキストボックスが Frame Rateドロップダウンリストに変わります。

Use system frame rateオプションが追加されています。このオプションで
は、Transport Controls ウィンドウで設定したものとは無関係な、異なるフレー
ムレートを選択できます。

A. User system frame rateチェックボックス、B. Frame Rateドロップダウンリスト

ヘルプの「Video 設定」を参照してください。

ネットワークライセンスのタイムアウトを設定
する

License Timeout オプションでは、ライセンスサーバからネットワークライセ
ンスがライセンスサーバの返還を要求される前にMotionBuilderセッションを
アイドル状態にしておく時間を定義します。MotionBuilderの Application プ
リファレンス設定で、ライセンスのタイムアウトを設定します。

ライセンスのタイムアウト時間を設定する場合、MotionBuilderの Application
プリファレンス設定で定義したタイムアウト時間を過ぎてもコンピュータ上で

MotionBuilderがアイドル状態になっていると、ライセンスはライセンスサー
バに返還されます。
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ライセンスのタイムアウトの Applicationプリファレンス設定

ヘルプの「Application プリファレンス設定」を参照してください。

Python および OR SDK のサンプルファイル
このリリースには新しい Python および SDK のサンプルファイルが含まれてい
ます。

製品に付属する新しい Python および SDK のサンプルファイルは次のとおりで
す。

Pythonのサンプルファイル

■ HUD.py

■ TimecodeKeying.py
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■ ImageSequenceFrameRateChange.py

■ SetPropertyStaticIfPossibleOption.py

■ CreateProfilingEventsLog.py

■ MultiPatchGeometry.py

■ AudioRendering.py

■ NamespaceOperationsOnTrack.py

OR SDKのサンプルファイル

■ ORDeviceTimeCode

■ ormaterial_template

■ ordevice_syncreference

FBX SDK のサポート
このリリースでは、他のオートデスク製品との一貫性を図る目的で、Autodesk
FBX SDK version 2013 がサポートされています。

Broadcast Wave Format (BWF)ファイルのサポー
ト

このリリースでは、放送で利用されるオーディオデータ用のファイルフォーマッ

トであるオーディオ Broadcast Wave Format (BWF)がサポートされています。

DDS ファイルフォーマットのサポート
このリリースでは、GPU への圧縮テクスチャの格納に使用されるDDS
(DirectDraw Surface) (バイナリ)ファイルフォーマットのサポートが DDS BC4、
DDS BC5、DDS ATI1、および DDS ATI2 ファイルに拡張されています。

MotionBuilderでは、DDS BC4、DDS BC5、DDS ATI1、および DDS ATI2 ファ
イルをフル解像度で読み込めるようになりました。

.ddsファイルは、テクスチャとしてマテリアルにロードできます。
MotionBuilder ヘルプの「マテリアルにテクスチャを追加する」を参照してく
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ださい。.ddsファイルをバックグラウンドテクスチャまたはフォアグラウンド
テクスチャとして使用できます。

.ddsファイルは、File > Import Video を選択してロードし、ビデオファイルと
して使用することもできます。DDS ファイルフォーマットでは、次のプロパ
ティがサポートされるようになりました。

■ ImageSequence

■ ImageSequenceOffset

■ UseSystemFrameRate

■ MaxMipMapResolution

これらのプロパティは、プロパティリソースで設定することができます。

事前定義された最高解像度は Full、1、2、4、8、16、32、64、128、256、512、
1K、2K、4K、8K、16K です。
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CgFX のサポート
このリリースでは、CgFX ライブラリの最新バージョンがサポートされていま
す。

MotionBuilderでは、CgFX ライブラリのバージョン 3 がサポートされているた
め、最新の CgFX シェーダ技術を活用できます。

サポートされていないオーディオファイル
フォーマット

MotionBuilder 2012 リリースでサポートされる一部のオーディオフォーマット
ファイルは、このリリースではサポートされません。

次のオーディオファイルフォーマットは、このリリースではサポートされませ

ん。

■ .mp2

■ .mpeg

■ .mpg

■ .mpg4

■ .sd2

■ .ulw

■ .vwf

オーディオアセットしてサポートされるファイルフォーマットのリストについ

ては、ヘルプの「オーディオファイルをロードする」を参照してください。

Timecode の拡張機能
このリリースでは、Timecode フレームレートの精度エラーが修正され、より
多くのフレームレートが追加され、時間の単位が 2 桁で表示されるようになり
ました。
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Timecode の精度

以前のリリースでは、23.976、29.97、72 などの再生フレームレートは、長時
間経過すると精度が減少しました。これらのフレームレートでの精度エラーは、

このリリースでは修正されました。新しい精度とレートは FBX に格納すること
ができます。

新しいフレームレートである 48、59.94、60、72、96、および 1000 は、
MotionBuilderのすべての Time Format メニューに追加されています。

Timecode フレームレートのリストについては、ヘルプの「Transport Controls
コンテキストメニュー」を参照してください。

Timecode の時間表示

Timecode の時間は、業界標準の 2 桁で表示されるようになりました。たとえ
ば、00:01:15 という形になります。

Align Control Rig プロパティ
前のリリースの Rig Align プロパティは、新しく Align Control Rig プロパティ
に置き換えられました。

Rig Align プロパティは、キャラクタ用の Control Rig プロパティの Align Control
Rig プロパティに置き換えられました。この変更の目的は、HIK 2013 ソルバを
使用してコントロールリグの位置合わせを解消する際に 1 つのプロパティのみ
を提供することです。
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